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Introduction
Thank you for purchasing the displacement sensor I/F unit UQ1 series. Before using this product, please 
confi rm this product is what you need.

 ● Please read this manual thoroughly and keep this manual at hand for proper use.

 ● When you lost this manual or had any questions and what you don’t understand, please contact our dis-
tributor that you purchased this product from.

 ● Copyright of any trade marks or registered marks shown on this manual are owned by each those compa-
nies.

 ● Copyright of this manual is owned by Optex-FA Co., Ltd. and protected by copyright law. Copying of this 
manual is prohibited.

 ●Warranty
When you found any malfunctions of this product, please contact our distributor that you purchased this 
product from. Warranty terms to be contracted between the customer and the distributor.
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Safety precautions
Before using this product, please read this manual carefully so that you can use this product correctly without 
any problems.

The important information described on this manual is to protect your health and property. Do not apply any 
other installing or operating procedure other than that described in this manual.

In this manual, safety precautions are classifi ed into two levels as follows.

 Warning Indicates that incorrect handling may cause hazardous conditions, resulting in death 
or severe injury.

 Caution Indicates that incorrect handling may cause hazardous conditions, resulting in minor 
or moderate injury or property damage.

Make sure to keep to following precautions

 Warning
• This product can not be used as protective equipment for the purpose of protecting human body.
• Disassembling or modifi cation of the product may cause injury, fi re or electric shock.
• When you felt smoke or foreign odor, please power off the product immediately and inform the dis-

tributor that you purchased the product from.
• Please use the product under rated voltage.
• Touching the product and cable with wet hand may cause electric shock.
• Please make sure that this product is used with specifi ed sensor head.
• Please do not wire, connect or disconnect while power supply is on.



iv

 

Installing precaution

 Warning
• Installing in the following places may cause breakdown, fi re or electric shock.

a. Humid place
b. High temperature place
c. Dusty place
d. Bad ventilation place
e. Very dry place with static electricity
f. A place with corrosive gas or fl ammable gas
g. A place with splash of water, oil or chemical
h. A place with vibration or shock

• Please wire while power supply is off.

 Caution
• Please do not wire with high voltage cable or high power line. It cause noise and malfunction. 

Please also shorten the wire as much as possible.
• Please prevent tension on the wire so that not to destroy the product.
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Feature

1.1 Feature

UQ1 series is interface unit that communicates with laser displacement sensor CD5/CD33 series and gets 
the measurement result into “Shared Memory”.
Following are the features.

1) UQ1 communicates with CD5/CD33 series and gets measurement result automatically.
2) UQ1 series setups CD5/CD33 series, getting measurement result from CD5/CD33 series, calculation and 

judges so rudder program is not needed for those process.
3) UQ1 series has control output terminal built-in so it works very fast, response time: 100us min., indepen-

dently of PLC sequencer.
4) Setup software that programs UQ1 series at start up is available. Please contact the distributor.
5) You can connect up to two CD5/CD33 series sensor heads to a UQ1 series unit. It is cost effective and 

also it’s easy to program calculation of thickness for example.
6) UQ1 series can communicate with other UQ1 series through “FIrST communication”, high speed infrared 

communication, without using Q-bus.
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1.2 Procedure summary

1.2.1 Procedure summary up to start up

System confi guration   →  Link: 1 General description

↓

Installing/Wiring of UQ1   →  Link: 2 System confi guration

↓

Start up of UQ1   →  Link: 4 Setup software

1.2.2  UQ1 series data fl ow
Data is processed in UQ1 series as following.

 ● In operation
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* The data fl ow above shows about UQ1-01. CD33 series sensor heads will be used for UQ1-02.
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1 Input data

         UQ1 series unit can get following data.
• Head A          : Measurement result of CD5/CD33 series sensor head A connected to UQ1-01/02
• Head B          : Measurement result of CD5/CD33 series sensor head B connected to UQ1-01/02
• Received data 1/2: Transmitted data specifi ed at “Transmission Data setup” from the UQ1-01/02 con-

nected to slave side.
Link: [2.1.1  FIrST communication]

2 Data calculation

         Received data can be calculated according to the setup at “Formula 1~3 (shared memory
          address 42~101)”.
         Link: [3.2.3  Judge setup]

3 Control output

         You can set threshold for the control output.
         5 control outputs, Q1~Q5, are available.

         You can specify which data to refer for the control output from Head A/B, Input Data 1/2 and
         Formula 1~3.
         You can add “offset” on specifi ed measured result.

Tips
• When Sensor head or Input Data assigned in the calculation formula is not connected, "0" will be 

applied.
• When you assign Sensor head that is not connected as the source of control output Q1~Q5, it will 

cause the error X1B~X1F. Although, there won't be any error if you assign next UQ1 unit at slave 
side as Input Data.

• When an error is occurred, you have to re-start up the power supply or set "Y16 error release" ON 
to release the error.

• UQ1 series continues the procedure from getting measured result up to output every constant period. 
This period is specifi ed by "Process time, at shared memory address 327 (us)" rounding out every 
100us. For example, when "Process time" is 140 (us), the constant period is 200 us.

• You can refer measured result of Sensor head A/B, Input Data 1/2, Calculation result 1~3 and con-
trol output Q1~Q5 through shared memory.

• FIrST communication will be done every updating period. When multiple UQ1 units are connected, 
the data is transferred through the units every updating period so total delay will be updating period 
* unit number connected to master unit.



1-5

Procedure summary

 ● Setup
Setup procedure is as follows.

1 Change setup parameters in shared memory

         Setup parameters in shared memory are at following address.
         Link: [3.1.4  Parameters in shared memory]

• Common setup parameters: address 0~126
• Parameters by Bank: address 128~159

         Change these parameters accordingly.
         Please refer “3 Process” for detailed of each parameter.

2 Activate Y (output device)

   Activate Y (output device) accordingly.

   Y10  Transfer setup parameters from shared memory to internal memory and CD5/CD33
 Transfer setup parameters from shared memory address 0~127
 to internal memory and CD5/CD33.
 Switch the Bank according to the Bank number specifi ed at shared memory address 102.
 (Please refer “Y08 Switching Bank”)
 X10 (input device: BUSY) will be ON while this process.

   Y08  Switching Bank
 Switching Bank
 Readout setup data of the Bank number specifi ed at shared memory address 102.
 Transfer the parameter data corresponding from Bank memory into shared memory
 address 128~159 and internal memory.
 X12 (input device: BUSY) will be ON while this process.

   Y11  Storing Bank setup
 Store the setup data into specifi ed Bank memory.
 Transfer the setup data from shared memory address 128~159
 into the Bank memory which number is specifi ed at shared memory address 102.
 X11 (input device: BUSY) will be ON while this process.
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Tips
• Data in the shared memory will be lost when the power is off. By activating Y10 and Y11, the ROM 

in the unit will be updated with the data in the shared memory not only the internal memory in the 
unit.

• When the unit is powered up without storing the data in the shared memory, it reboots with the data 
in the ROM in the unit.

• While BUSY is activated, the unit stops getting data from CD5/CD33, calculating and output.
• Storage transfer start pointer (shared memory address 124, 125) is reflected without activating 

any Y (output device). Bank number (shared memory address 102) is refl ected by activating Y08 
Switching Bank (output device). Please refer [3.2.6 Storage setup] about storage.

• While BUSY (X11~15) is activated, you won't be able to get correct data from the shared memory 
corresponding to the BUSY.
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1.3 Usable sequencer
Usable sequencer (CPU unit) is as follows.

CPU unit can be used with UQ1 Basic model QCPU

High Performance model QCPU

Process CPU

Redundant CPU(*)

Universal model QCPU

Remote I/O station

CPU unit can not be used with 
UQ1

C Controller unit

Safety CPU

* Can not install on main base unit and also can not proceed online module replacement.
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1.4 Specifi cations
Part number UQ1-01

Sampling period Min. 100μs

I/O points to occupy 32 points (I/O: Intelligent 32 points)

Communication method
(between UQ1 units)

Infrared

Terminal block Usable wire Core: 0.3 ~ 0.75mm2 (Outer diameter: Max. 2.8mm)

Usable Solderless 

terminal

R1.25-3 without sleeve

Communication I/F
(between UQ1 and 
CD5)

Number of head Max. 2 heads

Protocol RS-422

Baud rate 921.6kbps

Cable DOL-1212-G05M (5m sensor head cable)

Cable extension Up to 50m using optional extension cable (unbundled)

Control output Mode NPN open collector

Output voltage DC12-24V (±10%)

Output current 80mA (DC12-24V)

Residual voltage Max. 1.0V

Leak current Max. 0.2mA

Protection Over current protection circuitry

Trigger input Logic ON by connecting to GND (0V)

ON voltage Max. 1.0V

OFF voltage Min. 2.0V

Input impedance Approximately 10kΩ

Function Setup sensor head, Control output, Calculation, Hold function
Filter function, Bank setup, Storage function

EEPROM overwriting limit Max. 1000,000 times for same memory area

DC5V current consumption Max. 0.5A

Noise tolerance 500Vp-p (simulator), Noise width: 1μs
Fast transient noise 1kV (IEC 61000-4-4)

Insulation resistance Min. 10MΩ (insulation resistance meter)

Protection category IP2X

Operating Temp. / Humid. -10 ~ +55℃ / 35 ~ 85%RH (non condensation)

Storage Temp. / Humid. -20 ~ +70℃ / 35 ~ 85%RH (non condensation) 

Vibration resistance 10 ~ 55Hz Double amplitude  1.5mm  2 hours per X, Y, Z axis

Dimensions 98(H) * 27.4(W) * 90(D) [mm]

Weight Approximately 150g
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Part number UQ1-02

Sampling period Min. 100μs

I/O points to occupy 32 points (I/O: Intelligent 32 points)

Communication method
(between UQ1 units)

Infrared

Terminal block Usable wire Core: 0.3 ~ 0.75mm2 (Outer diameter: Max. 2.8mm)

Usable Solderless 

terminal

R1.25-3 without sleeve

Communication I/F
(between UQ1 and 
CD33)

Number of head Max. 2 heads

Protocol RS-422

Baud rate 256kbps

Control output Mode NPN open collector

Output voltage DC12-24V (±10%)

Output current 80mA (DC12-24V)

Residual voltage Max. 1.0V

Leak current Max. 0.2mA

Protection Over current protection circuitry

Trigger input Logic ON by connecting to GND (0V)

ON voltage Max. 1.0V

OFF voltage Min. 2.0V

Input impedance Approximately 10kΩ

Function Setup sensor head, Control output, Calculation, Hold function
Filter function, Bank setup, Storage function

EEPROM overwriting limit Max. 1000,000 times for same memory area

DC5V current consumption Max. 0.5A

Noise tolerance 500Vp-p (simulator), Noise width: 1μs
Fast transient noise 1kV (IEC 61000-4-4)

Insulation resistance Min. 10MΩ (insulation resistance meter)

Protection category IP2X

Operating Temp. / Humid. -10 ~ +55℃ / 35 ~ 85%RH (non condensation)

Storage Temp. / Humid. -20 ~ +70℃ / 35 ~ 85%RH (non condensation) 

Vibration resistance 10 ~ 55Hz Double amplitude  1.5mm  2 hours per X, Y, Z axis

Dimensions 98(H) * 27.4(W) * 90(D) [mm]

Weight Approximately 150g

* Cable for connector type CD33 are available; DOL-1208-G02M/5M (2m/5m)
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System installation

2.1 System installation
UQ1 series are installed on Q Bus as following example picture.
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Communication with QCPU 
through Q Bus

FIrST communication 
(between UQ1 units)

- You can connect up to 4 UQ1 series.
- You can connect up to 2 CD5 sensor heads to UQ1-01 unit.
- You can connect up to 2 CD33 sensor heads to UQ1-02 unit.
- UQ1 series utilize 2 ways of communication “Q Bus communication” and “FIrST communication”.
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2.1.1  FIrST communication
UQ1 units can communicate through “FIrST communication” utilizing infrared without using Q Bus.

 ● Advantages of “FIrST communication”
Advantages of “FIrST communication” are as follow.

<1> Fast communication

It works independently of the Q Bus so it can let UQ1 units communicate in 100μs in the shortest.

<2> Calculation using data from other QU1 unit

You can use measurement result from other UQ1 units installed next to the UQ1 unit (master side) for 
calculation. Up to 2 CD5/CD33 sensor heads can be connected to a unit and utilize more than 3 measure-
ment result through “FIrST communication” for calculation for example getting average of them.

Tips
<1>    “FIrST communication” is available only between adjacent UQ1 units.

UQ1 units must be installed at adjacent Bus.
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<Good>
Installed adjacently
"FIrST" is available

<No Good>
There is another unit 
between UQ1 units

No unit or another 
unit is installed.

<2>    Data is transferred only from slave side (far side from QCPU) to master side (near side
            of QCPU).
<3>    Setup of data transmission is done at slave side.

Master side (near side of QCPU) unit treats the data as “Input data 1” and “Input data 2” be-
cause it doesn’t know transmission setup.

- “FIrST communication” is  done every updating period.
- Up to 4 UQ1 units can  be connected and data is transferred from the unit at far side to near
   side of QCPU one by one. Then, it delays for total cycle of updating period.
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2.2 Display/Terminal/Wiring

2.2.1 Display / Terminal

 ●Display
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No. Item Description Note

1 IN1/2 Status of the terminal IN1/2 Orange when it's ON

2 OUT1/2 Status of the terminal OUT1/2 Orange when it's ON

3 LNK Status of FIsT communication between 
the unit and next unit at slave side.

Orange when the communication is 
made

4 JUDGE Status of the control output Q1~Q5. Orange when the control output is ON 
(X0B ~ X0F = 0)

5 ERR Error status of the control output Q1~Q5. Red when it's error. You can release the 
error by re-booting the unit or setting Er-
ror release Y16 ON.

Hole for FIrST communication
Please don’t cover or contaminate this part.
Please refer [�2.1.1 FIrST communication�
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6 HEAD A/B Show distance that Head A and B are 
measuring. When the distance is out of 
range, all LEDs blink.

<1> Measuring center (±10%)

<2> Measuring near side

LEDs ON depends on distance

<3> Out of range (blink)

<4> Laser is OFF (blink)

<5> Monitoring Wave
    - No light received (ON)

    - LED at the position of light peak
     is OFF

Tips
• Please refer [5.1.1 Process] about other status.
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 ● Terminal

UQ1 Terminal block

No. Terminal Function Note
1 [Head A] SDA Head A send (+) RS422 signals for Head A

(GND to be connected to 13 SG.)
2 [Head A] SDB Head A send (-)

3 [Head A] RDA Head A receive (+)
4 [Head A] RDB Head A receive (-)

5 [Head B] SDA Head B send (+) RS422 signals for Head B
(GND to be connected to 13 SG.)

6 [Head B] SDB Head B send (-)
7 [Head B] RDA Head B receive (+)

8 [Head B] RDB Head B receive (-)
9 Sync Out A Head A Sync out For preventing cross talk

10 Sync Out B Head B Sync out For preventing cross talk
11 Signal Out 1 Control out [1]

12 Signal Out 2 Control out [2]
13 SG Signal Ground GND of RS422 to be connected

14 Trigger In 1 Trigger in [1]
15 Trigger In 2 Trigger in [2]

16 COM(SG) I/O common (-) GND of [Sync Out], [Signal Out], [Trigger In]
 to be connected

17 12~24V I/O power (+) Plus line of DC12~24V power supply to be connected
(No.17 and 18 is connected internally on PCB)18 12~24V I/O power (+)
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2.2.2 Wiring
Please read this chapter carefully before wiring.

 Warning
Please confi rm that the source of power supply is shut down before wiring to prevent electric 
shock and damage of the product.
Please confi rm that the cover is fi xed over terminal block after wiring and before power on to 
prevent electric shock.

 Caution
To prevent malfunction and storing wrong data because of noise, please keep following.
1)  Please confi rm that communication lines are not banded with power line and high voltage 

line to prevent noise and surge induction.
2)  Please confi rm that the grounding of the cable shield line is done at a ground point of se-

quencer side. Please don't connect the ground line of high power line at the same ground-
ing point.

 ● Procedure
 ■ Shut down the power supply of sequencer.
 ■ Wire CD5 sensor to the unit (UQ1-01).
 ■ Wire CD33 sensor to the unit (UQ1-02).

 ● Terminal block
 ■ M3 screws are used for terminal block of UQ1 series.

Please use solder less terminal R1.25-3 (without sleeve).
Tightening torque : 0.5 ~ 0.8N･m
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12~24VDC

N.C.

2

4

6

8

10

1

3

5

7

9

11

13

15

17

12

14

16

18

Cable color Description
Black(narrow) RS422 input(+)

Orange RS422 input(-)

Red RS422 output(+)

Yellow RS422 output(-)

White Laser OFF input

Gray Sync input

Brown Power supply 12V~24V(±10%)

Blue Power supply 0V

Black(thick) Shield (0V)

12~24VDC

2

4

6

8

10

1

3

5

7

9

11

13

15

17

12

14

16

18

N.C.

Cable color Description
Black(narrow) RS422 input(+)

Orange RS422 input(-)

Red RS422 output(+)

Yellow RS422 output(-)

White Laser OFF input

Gray Sync input

Brown Power supply 12V~24V(±10%)

Blue Power supply 0V

Black(thick) Shield (0V)

 ● Input / Output Schematic (CD5)

Schematic (Head A)

Schematic (Head B)
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 ● Input / Output Schematic (CD33)

Schematic (Head A)

12～24VDC

No contact

Color Function

Black（narrow）RS422 Receive +

White RS422 Receive -

Orange RS422 Send +

Pink RS422 Send -

Purple Control output Q2

Gray MF

Brown Power 12V～24V(±10%)

Blue Power 0V

2

4

6

8

10

1

3

5

7

9

11

13

15

17

12

14

16

18

Schematic (Head B)

12～24VDC

No contact

2

4

6

8

10

1

3

5

7

9

11

13

15

17

12

14

16

18

Color Function

Black（narrow）RS422 Receive +

White RS422 Receive -

Orange RS422 Send +

Pink RS422 Send -

Purple Control output Q2

Gray MF

Brown Power 12V～24V(±10%)

Blue Power 0V
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 ●Grounding
- Please ground UQ1 series as following.
- Ground each equipment individually as much as available.
- Grounding impedance should be less than 100Ω.
- If you couldn’t ground equipment individually, please ground to common point.

UQ1 Other
equipment UQ1 UQ1

Individual grounding
(the best)

One point grounding
(OK)

Just connecting to ground
(No good)

Other
equipment

Other
equipment

- Please use thicker than AWG14(2mm2) for grounding line.
- Please shorten the grounding line as much as possible.
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2.2.3  Input / Output schematic

 ● Input schematic

Internal Power (+)

Le
ve

l S
hi

ft
er Trigger IN1

Trigger IN2

In
te

rn
al

 c
ir
cu

it
ry

Tips
• Function of the input (Trigger IN1/2) is defi ned at shared memory address 116~118.
• Input level is fetched every updating period of UQ1 independent of sequencer scan timing.

 ●Output schematic

Signal OUT 1
Signal OUT 2

COM

In
te

rn
a
l 
c
ir
c
u
it
ry

Tips
• Function of the out (Signal OUT1/2) is defi ned at shared memory 113~115.
• Output is updated every updating period of UQ1-01 independent of sequencer scan timing.



2-12

Display/Terminal/Wiring



3
Function



3-2

Shared memory and X/Y device

3.1 Shared memory and X/Y device
UQ1 series X/Y device table and function are as follows. Please refer chapter 2 about outline.

3.1.1 X/Y device table
Address of X/Y device is described in hexadecimal.

X (Input) Y (Output)
decimal hex. description decimal hex. Int. description

X00 X00 Unit ready (reserved) Y00 Y00 Yes Zero reset Q1
X01 X01 Q1 Upper (0= below "upper", 1= "upper" and over) Y01 Y01 Yes Zero reset Q2
X02 X02 Q1 Lower (0= over "lower", 1= "lower" and under) Y02 Y02 Yes Zero reset Q3
X03 X03 Q2 Upper Y03 Y03 Yes Zero reset Q4
X04 X04 Q2 Lower Y04 Y04 Yes Zero reset Q5
X05 X05 Q3 Upper Y05 Y05 Yes
X06 X06 Q3 Lower Y06 Y06 Yes
X07 X07 Q4 Upper Y07 Y07 Yes
X08 X08 Q4 Lower Y08 Y08 Switching Bank
X09 X09 Q5 Upper Y09 Y09 RESET
X10 X0A Q5 Lower Y10 Y0A Trigger IN A
X11 X0B Q1 judge (1=OK) Y11 Y0B Trigger IN B
X12 X0C Q2 judge (1=OK) Y12 Y0C Trigger IN Calculation 1
X13 X0D Q3 judge (1=OK) Y13 Y0D Trigger IN Calculation 2
X14 X0E Q4 judge (1=OK) Y14 Y0E Trigger IN Calculation 3
X15 X0F Q5 judge (1=OK) Y15 Y0F Getting Data stored
X16 X10 BUSY: Over writing Common setup Y16 Y10 Over writing common setup
X17 X11 BUSY: Over writing Bank setup Y17 Y11 Over writing Bank setup
X18 X12 BUSY: Switching Bank setup Y18 Y12 LASER OFF A (0=ON,1=OFF)
X19 X13 BUSY: Getting data stored Y19 Y13 LASER OFF B (0=ON,1=OFF)
X20 X14 BUSY: Switching Head A monitoring mode Y20 Y14 Head A Waveform mode *2
X21 X15 BUSY: Switching Head B monitoring mode Y21 Y15 Head B Waveform mode *2
X22 X16 Head A out of range alarm Y22 Y16 Error release
X23 X17 Head B out of range alarm Y23 Y17
X24 X18 Head A connection error *1 Y24 Y18
X25 X19 Head B connection error *1 Y25 Y19
X26 X1A FIrST data error *1 Y26 Y1A
X27 X1B Q1 Error (no target sensor head) *1 Y27 Y1B
X28 X1C Q2 Error (no target sensor head) *1 Y28 Y1C
X29 X1D Q3 Error (no target sensor head) *1 Y29 Y1D
X30 X1E Q4 Error (no target sensor head) *1 Y30 Y1E
X31 X1F Q5 Error (no target sensor head) *1 Y31 Y1F

*1  These errors can be released only by re-starting up the power supply or setting “Y16 error release” ON.
*2  Can be used only with specular type for UQ1-02.
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3.1.2 Shared memory table
Address of the shared memory is described in decimal.
Shared memory in the address 0~30 are different between UQ1-01 and UQ1-02.
■ UQ1-01

Item Address Default ParametersHex. Decimal

Sensor head A 
setup

Over written by 
Y10=1

Measurement target 0000h 0 0 0=Surface 1=Flip side 2= Glass thickness 3= Glass gap
Diffuse / Specular 0001h 1 0 0=Diffuse 1=Specular

Laser power 0002h 2 5 0=OFF 1~5 (5:MAX.)
Sensitivity 0003h 3 11 0=Min. 1~10 11=AUTO
Threshold for detecting peak 0004h 4 0 0~14 15=AUTO
Shift 0005h 5 0 LOW -50000000 b~ +50000000

  (Depends on the sensor head. Please refer [3.2.1  Sensor head setup])0006h 6 HI
Span 0007h 7 2710h

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0008h 8 HI
Moving average number 0009h 9 8 0=1 time 1=2 times 2=4 times 3=8 times 4=16 times 5=32 times 6=64 times 7=128 times

8=256 times 9=512 times A=1024 times B=2048 times C=4096 times

Alarm processing 000Ah 10 0 0=Clamp 1=Hold
Sampling period 000Bh 11 0 0=100us 1=200us 2=400us 3=800us 4=1600us 5=3200us 6=AUTO
Reserved 000Ch 12
Reserved 000Dh 13

Sensor head B 
setup

Over written by 
Y10=1

Measurement target 000Eh 14 0 0=Surface 1=Flip side 2= Glass thickness 3= Glass gap
Diffuse / Specular 000Fh 15 0 0=Diffuse 1=Specular

Laser power 0010h 16 5 0=OFF 1~5 (5:MAX.)
Sensitivity 0011h 17 11 0=Min. 1~10 11=AUTO
Threshold for detecting peak 0012h 18 0 0~14 15=AUTO
Shift 0013h 19 0 LOW -50000000 b~ +50000000

  (Depends on the sensor head. Please refer [3.2.1  Sensor head setup])0014h 20 HI
Span 0015h 21 2710h

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0016h 22 HI
Moving average number 0017h 23 8 0=1 time 1=2 times 2=4 times 3=8 times 4=16 times 5=32 times 6=64 times 7=128 times

8=256 times 9=512 times A=1024 times B=2048 times C=4096 times

Alarm processing 0018h 24 0 0=Clamp 1=Hold
Sampling period 0019h 25 0 0=100us 1=200us 2=400us 3=800us 4=1600us 5=3200us 6=AUTO
Reserved 001Ah 26
Reserved 001Bh 27

Sensor head A/B 
setup

Cross talk prevention func-
tion

001Ch 28 0 0=OFF 1=ON

fi lter choice 001Dh 29 0 0=OFF 1=High pass fi lter 1=Low pass fi lter
Cutoff frequency 001Eh 30 0 0=High ~ 7= Low

■ UQ1-02

Item Address Default ParametersHex. Decimal

Sensor head A 
setup

Over written by 
Y10=1

Measurement target 0000h 0 0 0= Peak 1= Surface 2=Flip side 3= Glass thickness
Reserved 0001h 1
Laser 0002h 2 1 0=OFF 1=ON
Reserved 0003h 3
Reserved 0004h 4
Shift 0005h 5 0 LOW -50000000 b~ +50000000

  (Depends on the sensor head. Please refer [3.2.1  Sensor head setup])0006h 6 HI
Span 0007h 7 2710h

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0008h 8 HI
Moving average number 0009h 9 1 0= 1 time 1=16 times 2=64 times
Alarm processing 000Ah 10 0 0=Clamp 1=Hold
Sampling period 000Bh 11 0 0=500us (250mm type: 750us) 1=1000us 2=1500us 3=2000us
Reserved 000Ch 12
Reserved 000Dh 13

Sensor head B 
setup

Over written by 
Y10=1

Measurement target 000Eh 14 0 0= Peak 1= Surface 2=Flip side 3= Glass thickness
Reserved 000Fh 15
Laser 0010h 16 1 0=OFF 1=ON
Reserved 0011h 17
Reserved 0012h 18
Shift 0013h 19 0 LOW -50000000 b~ +50000000

  (Depends on the sensor head. Please refer [3.2.1  Sensor head setup])0014h 20 HI
Span 0015h 21 2710h

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0016h 22 HI
Moving average number 0017h 23 1 0= 1 time 1=16 times 2=64 times
Alarm processing 0018h 24 0 0=Clamp 1=Hold
Sampling period 0019h 25 0 0=500us (250mm type: 750us) 1=1000us 2=1500us 3=2000us
Reserved 001Ah 26
Reserved 001Bh 27

Reserved 001Ch 28
Reserved 001Dh 29
Reserved 001Eh 30
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■ UQ1-01/02 common parameters 

Item Address Default ParametersHex. Dec.

UQ1 setup

Over written 
by Y10=1

High speed mode 001Fh 31 0 0=OFF 1=ON (It doesn’t do averaging when this parameter is 1=ON. “Auto average” and 
“Average” in measured result will be “0”.)

Q
1~

Q
5 

se
tu

p

Q1 Source 0020h 32 0 0=A 1=B 2= Formula 
1

3= Formula 
2

4= Formula 
3

5= Receiving 
data 1

6= Receiving 
data 2

7= None

Q1 Hold 0021h 33 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5= Average

Q2 Source 0022h 34 1 0=A 1=B 2= Formula 
1

3= Formula 
2

4= Formula 
3

5= Receiving 
data 1

6= Receiving 
data 2

7= None

Q2 Hold 0023h 35 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5= Average

Q3 Source 0024h 36 7 0=A 1=B 2= Formula 
1

3= Formula 
2

4= Formula 
3

5= Receiving 
data 1

6= Receiving 
data 2

7= None

Q3 Hold 0025h 37 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5= Average

Q4 Source 0026h 38 7 0=A 1=B 2= Formula 
1

3= Formula 
2

4= Formula 
3

5= Receiving 
data 1

6= Receiving 
data 2

7= None

Q4 Hold 0027h 39 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5= Average

Q5 Source 0028h 40 7 0=A 1=B 2= Formula 
1

3= Formula 
2

4= Formula 
3

5= Receiving 
data 1

6= Receiving 
data 2

7= None

Q5 Hold 0029h 41 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5= Average

Formula source 1-1 002Ah 42 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 1-1

Formula source 1-2 002Bh 43 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 1-2

Formula source 1-3 002Ch 44 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 1-3

Formula source 1-4 002Dh 45 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 1-4

Formula source 1-5 002Eh 46 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 1-5

Reserved 002Fh 47
Fixed value for Formula 
source  1-1

0030h 48 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0031h 49 HI

Fixed value for Formula 
source  1-2

0032h 50 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0033h 51 HI

Fixed value for Formula 
source  1-3

0034h 52 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0035h 53 HI

Fixed value for Formula 
source  1-4

0036h 54 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647) 
0037h 55 HI

Fixed value for Formula 
source  1-5

0038h 56 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647) 
0039h 57 HI

Operator 1-1 003Ah 58 0 0= + 1= - 2= * 3= ÷
Operator 1-2 003Bh 59 0 0= + 1= - 2= * 3= ÷
Operator 1-3 003Ch 60 0 0= + 1= - 2= * 3= ÷
Operator 1-4 003Dh 61 0 0= + 1= - 2= * 3= ÷
Formula source 2-1 003Eh 62 0 0= None 1=A 2=B 3= Receiving 

data 1
4= Receiving 
data 2

5= Fixed 
value 2-1

Formula source 2-2 003Fh 63 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 2-2

Formula source 2-3 0040h 64 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 2-3

Formula source 2-4 0041h 65 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 2-4

Formula source 2-5 0042h 66 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 2-5

Reserved 0043h 67
Fixed value for Formula 
source  2-1

0044h 68 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0045h 69 HI

Fixed value for Formula 
source  2-2

0046h 70 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0047h 71 HI

Fixed value for Formula 
source  2-3

0048h 72 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0049h 73 HI

Fixed value for Formula 
source  2-4

004Ah 74 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647) 
004Bh 75 HI

Fixed value for Formula 
source  2-5

004Ch 76 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647) 
004Dh 77 HI

Operator 2-1 004Eh 78 0 0= + 1= - 2= * 3= ÷
Operator 2-2 004Fh 79 0 0= + 1= - 2= * 3= ÷
Operator 2-3 0050h 80 0 0= + 1= - 2= * 3= ÷
Operator 2-4 0051h 81 0 0= + 1= - 2= * 3= ÷
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Item Address Default ParametersHex. Dec.

UQ1 Setup

Over written 
by Y10=1

Q
1~
Q
5 
/ C
al
cu
la
tio
n 
se
tu
p

Formula source 3-1 0052h 82 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 3-1

Formula source 3-2 0053h 83 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 3-2

Formula source 3-3 0054h 84 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 3-3

Formula source 3-4 0055h 85 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 3-4

Formula source 3-5 0056h 86 0 0= None 1=A 2=B 3= Receiving 
data 1

4= Receiving 
data 2

5= Fixed 
value 3-5

Reserved 0057h 87
Fixed value for Formula 
source  3-1

0058h 88 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
0059h 89 HI

Fixed value for Formula 
source  3-2

005Ah 90 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
005Bh 91 HI

Fixed value for Formula 
source  3-3

005Ch 92 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647)
005Dh 93 HI

Fixed value for Formula 
source  3-4

005Eh 94 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647) 
005Fh 95 HI

Fixed value for Formula 
source  3-5

0060h 96 0 LOW 080000000 h  (-2147483648) ~ 7FFFFFFFh (2147483647) 
0061h 97 HI

Operator 3-1 0062h 98 0 0= + 1= - 2= * 3= ÷
Operator 3-2 0063h 99 0 0= + 1= - 2= * 3= ÷
Operator 3-3 0064h 100 0 0= + 1= - 2= * 3= ÷
Operator 3-4 0065h 101 0 0= + 1= - 2= * 3= ÷

E
tc

.

Bank number 0066h 102 0 0 ~ 59  =  Bank 0 ~ 59
Hold mode 0067h 103 0 0 = Auto (data clear when RESET) 1 = Normal (data clear when sampling starts)
Hysteresis 0068h 104 0 LOW 0 ~ 7FFFFFFFh (2147483647) 

0069h 105 HI

O
ut

pu
t s

et
up

ON delay 006Ah 106 0 0= None 1 ~ 0FFFFh (65535) ms * Refl ect to Signal Out 1, 2 , X device
OFF delay 006Bh 107 0 0= None 1 ~ 0FFFFh (65535) ms * Refl ect to Signal Out 1, 2 , X device
One shot 006Ch 108 0 0=OFF 1=ON * Refl ect to Signal Out 1, 2 , X device
FIrST Transmit data 1 
setup

006Dh 109 0 0= Head A 1= Head B 2=Formula 
1

3=Formula 
2

4=Formula 
3

5= None

FIrST Transmit data 1 
Hold

006Eh 110 0 0= None 1=Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5=Average

FIrST Transmit data 2 
setup

006Fh 111 1 0= Head A 1= Head B 2=Formula 
1

3=Formula 
2

4=Formula 
3

5= None

FIrST Transmit data 2 
Hold

0070h 112 0 0= None 1=Sample 2= Peak 3= Bottom 4= Peak to 
Peak

5=Average

Signal Out 1 0071h 113 0 0=Q1 1=Q2 2=Q3 3=Q4 4=Q5 * ON when out side of threshold
Signal Out 2 0072h 114 1 0=Q1 1=Q2 2=Q3 3=Q4 4=Q5 * ON when out side of threshold
Signal Out logic 0073h 115 0 0= All 

normal
1=1 is 
reverse

2=2 is 
reverse

3= All 
reverse

In
pu

t s
et

up

Trigger timing of data 
sampling

0074h 116 0 0= OFF 1= ON 2= Up edge 3= Down edge * RESET effects at up 
edge only

Trigger IN 1 0075h 117 0 0= RESET 1= Head A 2= Head B 3=Formula 
1

4=Formula 
2

5=Formula 
3

Trigger IN 2 0076h 118 1 0= RESET 1= Head A 2= Head B 3=Formula 
1

4=Formula 
2

5=Formula 
3

D
at

a 
st

or
in

g

Data store skip number 0077h 119 0 0=No skip 1 ~ 0FFFFh (65535)
Source of data 0078h 120 0 0=Q1 1=Q2 2=Q3 3=Q4 4=Q5 5=Head A 6=Head B 7=Formula 

1
8= Formula 2 9= Formula 3 * Q1~Q5 will be added its offset.

Hold mode 0079h 121 0 0= None 1= Sample 2= Peak 3=Bottom 4= Peak to 
Peak

5=Average * Effective when the 
source of data is Head 
A ~ Formula 3 (5~9)

Pointer clear timing 007Ah 122 1 0=When Trigger is ON 1=When RESET is ON
Pointer end control 007Bh 123 1 0=Stop 1=Continue from start
Storage transfer start 
pointer

007Ch 124 0 LOW Start pointer number (0 ~ 245928) of the internal storage memory for transferring to 
shared memory. 262144 (14Eh~7FFDh) totally (every 16216). This is effective immedi-
ately after updating.007Dh 125 HI

Reserved 007Eh 126 0
Initialize Initialize 007Fh 127 0101h * Initialize by rebooting after setting this parameter "0"and Y10 as "1".
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Item Address Default ParametersHex. Dec.

Bank setup

Over written 
by Y11=1

Th
re

sh
ol

d 
/ O

ffs
et

Q1 Upper threshold 0080h 128 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0081h 129 HI

Q1 Lower threshold 0082h 130 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0083h 131 HI

Q2 Upper threshold 0084h 132 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0085h 133 HI

Q2 Lower threshold 0086h 134 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0087h 135 HI

Q3 Upper threshold 0088h 136 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0089h 137 HI

Q3 Lower threshold 008Ah 138 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)008Bh 139 HI

Q4 Upper threshold 008Ch 140 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)008Dh 141 HI

Q4 Lower threshold 008Eh 142 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)008Fh 143 HI

Q5 Upper threshold 0090h 144 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0091h 145 HI

Q5 Lower threshold 0092h 146 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)0093h 147 HI

Q1 Offset 0094h 148 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
0095h 149 HI

Q2 Offset 0096h 150 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
0097h 151 HI

Q3 Offset 0098h 152 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
0099h 153 HI

Q4 Offset 009Ah 154 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
009Bh 155 HI

Q5 Offset 009Ch 156 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
009Dh 157 HI

Reserved 009Eh 158
Reserved 009Fh 159

Result

Q
1~

Q
5 

re
su

lt

Q1 00A0h 160 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A1h 161 HI

Q2 00A2h 162 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A3h 163 HI

Q3 00A4h 164 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A5h 165 HI

Q4 00A6h 166 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A7h 167 HI

Q5 00A8h 168 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A9h 169 HI

C
en

te
r s

ta
nd

 o
ff Head A Center stand off 00AAh 170 Fixed value 

by type
LOW 2500000(25mm) ~ 200000000  (2000mm)

00ABh 171 HI
Head B Center stand off 00ACh 172 Fixed value 

by type
LOW 2500000(25mm) ~ 200000000  (2000mm)

00ADh 173 HI
Reserved 00AEh 174
Reserved 00AFh 175

M
ea

su
re

m
en

t r
es

ul
t

Head A 00B0h 176 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00B1h 177 HI

Head A Sample Hold 00B2h 178 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00B3h 179 HI

Head A Auto Peak Hold 00B4h 180 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00B5h 181 HI

Head A Peak Hold 00B6h 182 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00B7h 183 HI

Head A auto Bottom Hold 00B8h 184 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00B9h 185 HI

Head A Bottom Hold 00BAh 186 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00BBh 187 HI

Head A Auto Peak to 
Peak Hold

00BCh 188 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00BDh 189 HI

Head A Peak to Peak 
Hold

00BEh 190 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by "Pointer clear timing"00BFh 191 HI

■ Measurement result
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Item Address Default ParametersHex. Dec.

Result

M
ea

su
re

m
en

t r
es

ul
t

Head A Auto Average 
Hold

00C0h 192 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C1h 193 HI

Head A Average Hold 00C2h 194 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C3h 195 HI

Head A Count 00C4h 196 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C5h 197 HI

Head B 00C6h 198 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00C7h 199 HI

Head B Sample Hold 00C8h 200 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C9h 201 HI

Head B Auto Peak Hold 00CAh 202 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00CBh 203 HI

Head B Peak Hold 00CCh 204 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00CDh 205 HI

Head B auto Bottom Hold 00CEh 206 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00CFh 207 HI

Head B Bottom Hold 00D0h 208 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D1h 209 HI

Head B Auto Peak to 
Peak Hold

00D2h 210 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D3h 211 HI

Head B Peak to Peak 
Hold

00D4h 212 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D5h 213 HI

Head B Auto Average 
Hold

00D6h 214 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D7h 215 HI

Head B Average Hold 00D8h 216 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D9h 217 HI

Head B Count 00DAh 218 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00DBh 219 HI

Formula 1 00DCh 220 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00DDh 221 HI

Formula 1 Sample Hold 00DEh 222 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00DFh 223 HI

Formula 1 Auto Peak 
Hold

00E0h 224 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E1h 225 HI

Formula 1 Peak Hold 00E2h 226 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E3h 227 HI

Formula 1 Auto Bottom 
Hold

00E4h 228 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E5h 229 HI

Formula 1 Bottom Hold 00E6h 230 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E7h 231 HI

Formula 1 Auto Peak to 
Peak Hold

00E8h 232 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E9h 233 HI

Formula 1 Peak to Peak 
Hold

00EAh 234 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00EBh 235 HI

Formula 1 Auto Average 
Hold

00ECh 236 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00EDh 237 HI

Formula 1 Average Hold 00EEh 238 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00EFh 239 HI

Formula 1 Count 00F0h 240 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F1h 241 HI

Formula 2 00F2h 242 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00F3h 243 HI

Formula 2 Sample Hold 00F4h 244 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F5h 245 HI

Formula 2 Auto Peak 
Hold

00F6h 246 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F7h 247 HI

Formula 2 Peak Hold 00F8h 248 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F9h 249 HI

Formula 2 Auto Bottom 
Hold

00FAh 250 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00FBh 251 HI

Formula 2 Bottom Hold 00FCh 252 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00FDh 253 HI

Formula 2 Auto Peak to 
Peak Hold

00FEh 254 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00FFh 255 HI

Formula 2 Peak to Peak 
Hold

0100h 256 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0101h 257 HI

Formula 2 Auto Average 
Hold

0102h 258 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0103h 259 HI

Formula 2 Average Hold 0104h 260 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0105h 261 HI

Formula 2 Count 0106h 262 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0107h 263 HI

Formula 3 0108h 264 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0109h 265 HI

Formula 3 Sample Hold 010Ah 266 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”010Bh 267 HI

Formula 3 Auto Peak 
Hold

010Ch 268 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”010Dh 269 HI

Formula 3 Peak Hold 010Eh 270 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”010Fh 271 HI
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Item Address Default ParametersHex. Dec.

Result

M
ea

su
re

m
en

t r
es

ul
t

Formula 3 Auto Bottom 
Hold

0110h 272 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0111h 273 HI

Formula 3 Bottom Hold 0112h 274 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0113h 275 HI

Formula 3 Auto Peak to 
Peak Hold

0114h 276 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0115h 277 HI

Formula 3 Peak to Peak 
Hold

0116h 278 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0117h 279 HI

Formula 3 Auto Average 
Hold

0118h 280 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0119h 281 HI

Formula 3 Average Hold 011Ah 282 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”011Bh 283 HI

Formula 3 Count 011Ch 284 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”011Dh 285 HI

Receiving data 1 011Eh 286 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
011Fh 287 HI

Receiving data 2 0120h 288 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0121h 289 HI

Reserved 0122h 290
Reserved 0123h 291
Reserved 0124h 292
Reserved 0125h 293
Reserved 0126h 294
Reserved 0127h 295

E
le

m
en

t o
f F

or
m

ul
a

Element 1 of Formula 1 0128h 296 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0129h 297 HI

Element 2 of Formula 1 012Ah 298 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
012Bh 299 HI

Element 3 of Formula 1 012Ch 300 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
012Dh 301 HI

Element 1 of Formula 2 012Eh 302 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
012Fh 303 HI

Element 2 of Formula 2 0130h 304 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0131h 305 HI

Element 3 of Formula 2 0132h 306 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0133h 307 HI

Element 1 of Formula 3 0134h 308 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0135h 309 HI

Element 2 of Formula 3 0136h 310 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0137h 311 HI

Element 3 of Formula 3 0138h 312 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0139h 313 HI

Reserved 013Ah 314
Reserved 013Bh 315
Reserved 013Ch 316
Reserved 013Dh 317
Reserved 013Eh 318
Reserved 013Fh 319

Error status

Calculation Over-
fl ow

Formula 1 0140h 320 0 B0= Element 1 B1= Element 2 B2= Element 3 B3= Formula 1
Formula 2 B4= Element 1 B5= Element 2 B6= Element 3 B7= Formula 2
Formula 3 B8= Element 1 B9= Element 2 B10= Element 3 B11= Formula 3
Head A B12= Out of range
Head B B13= Out of range

Reserved 0141h 321
Reserved 0142h 322
Reserved 0143h 323

Unit status

Current Bank number 0144h 324 0 0 ~ 59  =  Bank 0 ~ 59
Version 0145h 325 Version
Q1~Q5 and source status 0146h 326 0 B0=Head A B 1 = H e a d 

B
B2=
Formula 1

B3=
Formula 2

B4=
Formula 3

B5=
Receiving 
data 1

B6=
Receiving 
data 2

B11=Q1 B12=Q2 B13=Q3 B14=Q4 B15=Q5
Response speed (μs) 0147h 327
Storage current pointer 0148h 328 0 LOW 0 ~ 262143  (When the pointer reaches end and “Pointer end control” is 0=Stop, it will 

stop at 262143. When “Pointer end control” is 1= Continue from start, it restarts from 0.)0149h 329 HI
Storage overfl ow 014Ah 330 0= Pointer is less than 

262143
1= Overfl ow

Unit status
Reserved 014Bh 331
Reserved 014Ch 332
Reserved 014Dh 333

Loaded data

1st Depends on "Source of 
data" address 120

014Eh 334 LOW Depends on "Source of data" address 120
014Fh 335 HI

~ ~
16216
th

Depends on "Source of 
data" address 120

7FFCh 32764 LOW Depends on "Source of data" address 120
7FFDh 32765 HI

Reserved
7FFEh 32766
7FFFh 32767
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 ●Waveform mode
When Y14, Y15 “Head A/B Waveform mode” is ON, shared memory address 334 ~ 1329 will be updat-
ed with Waveform data.

Item Address Default Parameters
Hex. Decimal

Waveform data

Head A Threshold level 014Eh 334 0 ~ 255  (0FFh): UQ1-01
0 ~ 4095 (0FFFh): UQ1-02
65535 (0FFFFh): UQ1-02 (non applicable sensor head)

Peak position 1 014Fh 335 0 ~ 511  (01FFh)
Peak position 2 0150h 336 0 ~ 511  (01FFh)
Waveform data 1 0151h 337 0 ~ 255  (0FFh)
~ ~
Waveform data 480 (UQ1-01 end of data) 0331h 817 0 ~ 255  (0FFh)
Waveform data 508 (UQ1-02 end of data) 034Dh 845 0 ~ 4095  (0FFFh)

Head B Threshold level 034Eh 846 0 ~ 255  (0FFh): UQ1-01
0 ~ 4095 (0FFFh): UQ1-02
65535 (0FFFFh): UQ1-02 (non applicable sensor head)

Peak position 1 034Fh 847 0 ~ 511  (01FFh)
Peak position 2 0350h 848 0 ~ 511  (01FFh)
Waveform data 1 0351h 849 0 ~ 255  (0FFh)
~ ~
Waveform data 480 (UQ1-01 end of data) 0531h 1329 0 ~ 255  (0FFh)
Waveform data 508 (UQ1-02 end of data) 054Dh 1357 0 ~ 4095  (0FFFh)
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3.1.3  X / Y device in detail

X (input) device

X (input) device is input from UQ1 unit to PLC. It can’t be driven by PLC.

Y (output) device

Y (output) device is output from PLC to UQ1 unit. It can’t be driven by UQ1 unit.

 ● X (input) device in detail

X00

Reserved. Not to be used.

X01~X0A   Upper/Lower status

When Q1~Q5 output is larger (smaller) than Upper/Lower threshold, it will be ON accordingly.

X0B~X0F   Judge status

When Q1~Q5 output is in the Upper and Lower threshold level.

Tips
  About X01~X0F;
When setup is done correctly, one out of these status will be ON.
For example, regarding Q1, one out of X01~X0A and X0B will be ON.
If the source of the control output (shared memory address 32 for Q1 for example) is "NONE", these 
device won't be ON.

BUSY status (X10 / X11 / X12 / X13 / X14 / X15)

BUSY will be activated when UQ1 series can't get measurement result from CD5/CD33.
While the BUSY is ON, reading shared memory will be stopped.
Please don't write anything on shared memory while BUSY is active.

X10   BUSY: Over writing common setup

BUSY (X10) will be ON while over writing common setup.
After activating “Y10 Over writing common setup”, common setup parameters in shared memory will be 
over written into the ROM of UQ1 unit.

X11   BUSY: Over writing Bank setup

BUSY (X11) will be ON while over writing Bank setup.
After activating “Y11 Over writing Bank setup”, Bank setup parameters in shared memory will be over writ-
ten into the ROM of UQ1 unit.
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X12   BUSY: Switching Bank setup

BUSY (X12) will be ON while switching Bank setup.
After activating “Y08 Switching Bank setup”, read out setup parameters of the Bank number specifi ed at 
shared memory address 102.

X13   BUSY: Getting data stored

BUSY (X13) will be ON while getting data into shared memory.
After activating “Y0F Getting data stored”, get the data from the internal memory of UQ1 unit into shared 
memory. Please refer [3.2.6   Storage setup].

X14 ~ X15   BUSY: Switching Head A/B monitoring mode

BUSY (X14, X15) will be ON while switching monitoring mode of the Head A/B at the up edge and down 
edge of “Y14/15 Head A/B Waveform mode”.

X16 ~ X17   Head A/B out of range alarm

Alarm (X16, X17) will be ON while CD5/CD33 sensor head is alarming that it can not detect any objects in 
the range whatever the monitoring mode is.
When the sensor head detects the object in the range, the alarm will be OFF.

Error status  (X18 / X19 / X1A / X1B / X1C / X1D / X1E / X1F)

Error will be ON when the communication or measurement is not done correctly.
Once, the error is ON, it won’t be OFF even the conditions are released.
Please proceed one of following to release this error.

- Power OFF and Power ON
- Activate “Y16 Error release”

X18 ~ X19   Head A/B connection error

Error (X18, X19) will be ON when the RS-422 connection between CD5/CD33 sensor head and UQ1 unit 
has problems.
This Error won’t be ON if the sensor head which has connection problem is not assigned as source of out-
put (Q1~Q5).

X1A   FIrST data error

Error (X1A) will be ON when the UQ1 unit can’t get data from another UQ1 unit next to it.
This Error won’t be ON if the input data 1 and 2 are not assigned as source of output (Q1~Q5).

X1B ~ X1F   Q1~Q5 Error

This Error (X1B~X1F) will be ON when one of following two conditions is fulfi lled.
- The sensor head that is assigned to the output (Q1~Q5) is not connected.
- Overfl owed while calculation that is assigned to the output (Q1~Q5).

This Error won’t be ON if the source of output (Q1~Q5) is “NONE”.
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 ● Y (output) device in detail

Y00 ~ Y04   Zero reset

Zero reset input for the output Q1~Q5.
It resets measured result to “0” at the up edge of the zero reset input adjusting offset.
BUSY (X11) will be ON while Zero reset.

Y08   Switching Bank

By activating “Y08”, it switches Bank.
It reads out Bank setup parameters of the Bank number specifi ed at shared memory address 102 and 
over write shared memory address 128~157 at up edge of this device.
BUSY (X12: Switching Bank) will be ON while switching Bank.

Y09   RESET

By activating “Y09”, it resets the UQ1 unit.
It clears the value held in “Hold mode”.
While Data clear timing (shared memory address 122) is “1=only when RESET”, it clears the value held in 
“Hold mode”.

Y0A ~ Y0E   Trigger IN

Trigger input for sensor head A/B and calculation 1/2/3.
Trigger can be input to Y device and terminal block.

Tips
When the trigger is input from terminal block, It works regardless of scan timing of the sequencer.

Y0F   Getting Data stored

Start transfer of data stored.
While measurement, the data is stored into internal memory of the unit.
By activating “Y0F”, the data is transferred from internal memory to shared memory.
Please refer [3.2.6   Storage setup].
While transferring the data, X13 BUSY: Getting Data stored will be ON.

Y10   Over writing common setup

Start over writing common setup parameters.
Just changing parameters in the shared memory doesn’t affect actual process of the unit.
By activating this “Y10” device, the parameters are over written on the memory for processing and come 
into effect.
The parameters to be over written are in the shared memory address 0~127 except reserved area.
It reads out Bank setup parameters of the Bank number specifi ed at shared memory address 102 and 
over write shared memory address 128~157 at up edge of this device.
While over writing the data, X10 BUSY Over writing common setup will be ON.
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Y11   Over writing Bank setup

Start over writing Bank setup parameters including upper and lower threshold.
Just changing parameters in the shared memory doesn’t affect actual process of the unit.
By activating this “Y11” device, the parameters are over written on the memory for processing and come 
into effect.
The parameters to be over written are in the shared memory address 128~157 except reserved area.
While over writing the data, X11 BUSY Over writing Bank setup will be ON.

Y12 ~ Y13   LASER OFF

You can make the laser output of each CD5/CD33 sensor head OFF by activating this device.
While laser is OFF, measurement is stopped.

Y14 ~ Y15   Waveform mode

By activating this device, monitoring mode of each sensor head is changed to Waveform monitoring 
mode. While it’s Waveform mode, the sensor head doesn’t measure but update the Waveform data on.

Y16   Error release

You can release Error by activating this device.
Besides activating this device, you can release the Error by restart power supply of the UQ1 unit.
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3.1.4 Parameters in shared memory
  Major parameters in the shared memory are as follows.

Common setup parameters

Address: 0~126
Parameters for CD5 sensor head and UQ1 unit.
Please change parameters hear fi rstly to change setup.

Common setup parameters consist of following.
- Setup of sensor head A/B
- High speed mode (ON/OFF)
- Output and Calculation
- Etc.
- Output setup / Trigger input
- Data storing

Initialize

Address: 127
Initialize setup of UQ1 unit.

Bank setup parameters

Address: 128~159
Threshold level and offset for every Bank.
When the Bank is switched, the parameters will be over written.

The parameters include:
- Q1~Q5 Upper/Lower threshold
- Q1~Q5 Offset

Measurement result

Address: 160~319
Result (value) will be shown.

The result include:
- Q1~Q5 result
- Center stand off
- Measurement result
- Calculation factor

Error status

Address: 320~323
Shows every error status.
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Unit status

Address: 324~333
Shows every status of the unit.

Loaded data

Address: 334~32767
Will be updated when getting data from internal memory.
Please refer [3.2.6  Storage setup] about setup of getting data stored.

Waveform data

Address: 334~1329
Will be updated when Waveform monitoring mode.

Tips
Please don't access "Reserved" area of shared memory.
It may cause malfunction of UQ1 unit.
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3.2 Parameters in detail

3.2.1  Sensor head setup
Following parameters (shared memory address 0~30) are for setup of CD5/CD33 sensor head.
■ UQ1-01

Item
Address

Default Parameters
Hex. Decimal

Sensor 
head A 
setup

Over 
written by 
Y10=1

Measurement target 0000h 0 0 0=Surface 1=Flip side 2= Glass thickness 3= Glass gap
Diffuse / Specular 0001h 1 0 0=Diffuse 1=Specular
Laser power 0002h 2 5 0=OFF 1~5 (5: MAX.)
Sensitivity 0003h 3 11 0=Min. 1 ~ 10 11=AUTO
Threshold 0004h 4 0 0~14 15=AUTO
Shift 0005h 5 0 LOW -50000000 ~ +50000000  (depends on the sensor head)

0006h 6 HI
Span 0007h 7 2710H

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0008h 8 HI
Moving average 
number

0009h 9 8 0=1 time 1=2 times 2=4 times 3=8 times 4=16 times 5=32 times 6=64 times 7=128 times
8=256 times 9=512 times A=1024 times B=2048 times C=4096 times

Alarm processing 10 0 0=Clamp 1=Hold
Sampling period 000Bh 11 0 0=100us 1=200us 2=400us 3=800us 4=1600us 5=3200us 6=AUTO
Reserved 000Ch 12
Reserved 000Dh 13

Sensor 
head B 
setup

Over 
written by 
Y10=1

Measurement target 000Eh 14 0 0=Surface 1=Flip side 2= Glass thickness 3= Glass gap
Diffuse / Specular 000Fh 15 0 0=Diffuse 1=Specular
Laser power 0010h 16 5 0=OFF 1~5 (5: MAX.)
Sensitivity 0011h 17 11 0=Min. 1 ~ 10 11=AUTO
Threshold 0012h 18 0 0~14 15=AUTO
Shift 0013h 19 0 LOW -50000000 ~ +50000000  (depends on the sensor head)

0014h 20 HI
Span 0015h 21 2710H

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0016h 22 HI
Moving average 
number

0017h 23 8 0=1 time 1=2 times 2=4 times 3=8 times 4=16 times 5=32 times 6=64 times 7=128 times
8=256 times 9=512 times A=1024 times B=2048 times C=4096 times

Alarm processing 24 0 0=Clamp 1=Hold
Sampling period 0019h 25 0 0=100us 1=200us 2=400us 3=800us 4=1600us 5=3200us 6=AUTO
Reserved 001Ah 26
Reserved 001Bh 27

Sensor 
head A/B 
setup

Cross talk prevention 
function

001Ch 28 0 0=OFF 1=ON

Filter choice 001Dh 29 0 0=OFF 1=High pass 2=Low pass
Cutoff frequency 001Eh 30 0 0=High ~ 7= Low

■UQ1-02
Item

Address
Default Parameters

Hex. Decimal

Sensor 
head A 
setup

Over 
written by 
Y10=1

Measurement target 0000h 0 0 0= Peak 1= Surface 2=Flip side 3= Glass thickness
Reserved 0001h 1
Laser 0002h 2 1 0=OFF 1=ON
Reserved 0003h 3
Reserved 0004h 4
Shift 0005h 5 0 LOW -50000000 b~ +50000000

  (Depends on the sensor head. Please refer [3.2.1  Sensor head setup])0006h 6 HI
Span 0007h 7 2710h

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0008h 8 HI
Moving average number 0009h 9 1 0= 1 time 1=16 times 2=64 times
Alarm processing 000Ah 10 0 0=Clamp 1=Hold
Sampling period 000Bh 11 0 0=500us (250mm type: 750us) 1=1000us 2=1500us 3=2000us
Reserved 000Ch 12
Reserved 000Dh 13

Sensor 
head A 
setup

Over 
written by 
Y10=1

Measurement target 000Eh 14 0 0= Peak 1= Surface 2=Flip side 3= Glass thickness
Reserved 000Fh 15
Laser 0010h 16 1 0=OFF 1=ON
Reserved 0011h 17
Reserved 0012h 18
Shift 0013h 19 0 LOW -50000000 b~ +50000000

  (Depends on the sensor head. Please refer [3.2.1  Sensor head setup])0014h 20 HI
Span 0015h 21 2710h

(10000)
LOW 0 ~ 9C3Fh (0 ~ 39999)   Example:  10000 means  Span=1.0000

0016h 22 HI
Moving average number 0017h 23 1 0= 1 time 1=16 times 2=64 times
Alarm processing 0018h 24 0 0=Clamp 1=Hold
Sampling period 0019h 25 0 0=500us (250mm type: 750us) 1=1000us 2=1500us 3=2000us
Reserved 001Ah 26
Reserved 001Bh 27
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CD5/CD33 sensor head has setup parameters same as shared memory 0~25. These parameters will be over 
written with the parameters in shared memory when UQ1 unit detects CD5/CD33 sensor head connected.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR

  IN   1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

24VDC
80mA

CD5UQ1

Process at detection of CD5

Parameters will be 
over written

- Address 0~30
- Baud rate

 ●Measurement target
Choose measurement target mode.

- Peak: Most refl ective point (only UQ1-02)
- Surface: Measurement target is the surface of the object. Please use this mode normally.
- Flip side: 2nd surface of the object. Flip side of glass plate for example.
- Glass thickness: Measures distance between 1st surface and 2nd surface.
   Transparent glass thickness for example. Available with only specular type sensor head.
- Glass gap: Measures distance between 2nd surface and 3rd surface.
   Gap between layered glasses for example. Available with only specular type sensor head.

[Parameters]
UQ1-01 UQ1-02

0: Surface 0: Peak
1: Flip side 1: Surface
2: Glass thickness 2: Flip side
3: Glass gap 3: Glass thickness

 ●Diffuse / Specular (UQ1-01)
Specify refl ection mode of the laser. Please use diffuse mode for the surface that is not refl ective or glossy. 
Please use specular mode for refl ective surface like glass or clean metal surface.

 ● Laser power (UQ1-01) / Laser (UQ1-02)
Specify laswer power from 0 to 5 for CD5 connected to UQ1-01. It switches laswer power ON or OFF for 
CD33 connected to UQ1-02. When it's 0, it stops measurement.

[Parameters]
UQ1-01 UQ1-02

0 : Laser OFF 0: Laser OFF
1 ~ 5 : Laser power (1: low ~ 5: High) 1: Laser ON

CD33
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 ● Sensitivity (UQ1-01)
Specify sensitivity of laser sensor in the sensor head. It should be set 11 (Auto) normally. When it’s 11 (auto), 
the sensor adjusts the sensitivity automatically depends on the strength of the refl ection. It takes 2msec. (Max.) 
to adjust so please fi x the sensitivity when the refl ection changes quickly and drastically.
Example: When the object is refl ective metal surface and the object continues disappearing from its view and 
appear in a view quickly, measurement could be stable by fi xing sensitivity.

[Parameters]
0~10 : 0 (weak) ~ 10 (strong)
11 : AUTO

 ● Threshold (UQ1-01)
Specify threshold level of CD5 to detect peak point of Waveform.
It should be “0” normally.

Tips
Please adjust the threshold level checking Waveform adequately when the object is transparent. 
Please refer "Setup software".
Setting "15: Auto" may make measurement stable but might cause less linearity.

[Parameters]
0~14 : Threshold 0 (low) ~ 14 (high)
15 : AUTO

 ● Shift / Span
Setup Shift and Span to cancel deviation of position and gradient of the sensor head. Please refer “Setup 
software” when you calibrate the sensor. Setup range of Shift is as follows depending to sensor head.

Sensor type
Range of Shift

Minimum Maximum
CD5-Lx25 -100000 (-1mm) 100000 (1mm)
CD5-x30 -500000 (-5mm) 500000 (5mm)
CD5-x85 -2000000 (-20mm) 2000000 (20mm)

CD5-W350 -10000000 (-100mm) 10000000 (100mm)
CD5-W500 -20000000 (-200mm) 20000000 (200mm)

CD5-W2000 -50000000 (-500mm) 50000000 (500mm)
Please calculate Shift and Span as following.
[Shift calculation]

Example (CD5-x85): When correct +85.400mm to +85.000mm
Stand off: 85mm
Measurement range: ±20mm
(85.000 - 85.400)/(20 * 2)= -0.0100
Please input -00100
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[Span calculation]
Example (CD5-x85): When correct the distance 10.100mm to 10.000mm
10.100/10.000=1.0100
Please input 10100

 ●Moving average number
The bigger number, the more stable measurement is and counteract roughness of the surface.
The smaller number, the higher response speed is and detect quick change of the distance.

 ●Alarm processing
Specify the process when the sensor head A/B malfunction.
[Parameters]

0: Clamp   (output “99999999” when malfunction)
1: Hold   (hold previous measurement value when malfunction. It doesn’t output “X16, X17 out of range 
alarm”.)

 ● Sampling period
Specify sampling period of CD5 sensor head.
The shorter period, the faster response but sensitivity will be worse.
When the sampling period is set “6: AUTO”, sampling period will be adjusted and optimized automatically (only  
with UQ1-01)

Fast

Low High

SlowResponse

Sensitivity

100μs 3200μs・・・・・

[Parameters]
UQ1-01 UQ1-02

0: 100us 0: 500us  / 750us  (250mm type)
1: 200us 1: 1000us
2: 400us 2: 1500us
3: 800us 3: 2000us
4: 1600us
5: 3200us
6: AUTO

 ●Cross talk prevention function (UQ1-01)
When multiple CD5 sensor heads target same point, measurement may be unstable because of cross talk.
You can prevent cross talk by setting “Cross talk prevention function” ON. Please note that sampling period 
will be 6 times in that case.
Please set this parameter OFF when there is no possibility of cross talk.
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 ● Filter choice (UQ1-01)
You can choose frequency band “High pass fi lter” or “Low pass fi lter” for UQ1 series.
- High pass fi lter: You can get higher frequency band more than the cutoff frequency.
- Low pass fi lter : You can get low frequency band less than the cutoff frequency.

High pass filter

Low pass filter

[Parameters]
0: OFF
1: High pass fi lter
2: Low pass fi lter

Tips
• When set High pass fi lter or Low pass fi lter, please set Moving average number (shared memory 

address 9, 23) as "0: 1 time".

 ●Cutoff frequency (UQ1-01)
Specify Cutoff frequency for High or Low pass fi lter.
Please choose the cutoff frequency from 8 level. Actual cutoff frequency depends on the sampling period
Please refer “6.1.1  Cutoff frequency of the fi lter” for actual cutoff frequency.

[Parameters]
0 ~ 7: Frequency level (0: High ~ 7: low)
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3.2.2  High speed mode

Item
Address

Default Parameters
Hex. Decimal

High speed mode 001Fh 31 0 0=OFF 1=ON (It doesn't do averaging when this parameter is 1=ON. "Auto average" and "Aver-
age" in measured result will be "0".)

It speeds up calculation by not doing averaging in High speed mode.
This mode to be used when process time of UQ1 series is longer than sampling period of CD5 sensor.
If you use averaging of measured data, this parameter must be “0=OFF”.
You can confi rm current process time at “Process time (shared memory address 327)”.

[Parameters]
0: High speed mode=OFF (all of measured data at shared memory address 176~289 will be updated.)
1: High speed mode=ON (only “Auto average” and “Average” in measured data at shared memory ad-

dress 176~289 will not be updated.)
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3.2.3   Q1~Q5 / Calculation setup
Item

Address
Default Parameters

Hex. Decimal

Q
1~

Q
5 

/ C
al

cu
la

tio
n 

se
tu

p

Q1 Source 0020h 32 0 0=A 1=B 2= Formula 1 3= Formula 2 4= Formula 3 5= Receiving data1 6= Receiving data2 7= None
Q1 Hold 0021h 33 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to Peak 5= Average
Q2 Source 0022h 34 1 0=A 1=B 2= Formula 1 3= Formula 2 4= Formula 3 5= Receiving data1 6= Receiving data2 7= None
Q2 Hold 0023h 35 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to Peak 5= Average
Q3 Source 0024h 36 7 0=A 1=B 2= Formula 1 3= Formula 2 4= Formula 3 5= Receiving data1 6= Receiving data2 7= None
Q3 Hold 0025h 37 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to Peak 5= Average
Q4 Source 0026h 38 7 0=A 1=B 2= Formula 1 3= Formula 2 4= Formula 3 5= Receiving data1 6= Receiving data2 7= None
Q4 Hold 0027h 39 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to Peak 5= Average
Q5 Source 0028h 40 7 0=A 1=B 2= Formula 1 3= Formula 2 4= Formula 3 5= Receiving data1 6= Receiving data2 7= None
Q5 Hold 0029h 41 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to Peak 5= Average
Formula source 1-1 002Ah 42 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 1-1

Formula source 1-2 002Bh 43 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 1-2

Formula source 1-3 002Ch 44 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 1-3

Formula source 1-4 002Dh 45 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 1-4

Formula source 1-5 002Eh 46 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 1-5

Reserved 002Fh 47
Fixed value for For-
mula source 1-1

0030h 48 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0031h 49 HI

Fixed value for For-
mula source 1-2

0032h 50 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0033h 51 HI

Fixed value for For-
mula source 1-3

0034h 52 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0035h 53 HI

Fixed value for For-
mula source 1-4

0036h 54 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0037h 55 HI

Fixed value for For-
mula source 1-5

0038h 56 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0039h 57 HI

Operator 1-1 003Ah 58 0 0= + 1= - 2= * 3=÷
Operator 1-2 003Bh 59 0 0= + 1= - 2= * 3=÷
Operator 1-3 003Ch 60 0 0= + 1= - 2= * 3=÷
Operator 1-4 003Dh 61 0 0= + 1= - 2= * 3=÷
 Formula source 2-1 003Eh 62 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 2-1

 Formula source 2-2 003Fh 63 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 2-2

 Formula source 2-3 0040h 64 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 2-3

 Formula source 2-4 0041h 65 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 2-4

 Formula source 2-5 0042h 66 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 2-5

Reserved 0043h 67
Fixed value for For-
mula source 2-1

0044h 68 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0045h 69 HI

Fixed value for For-
mula source 2-2

0046h 70 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0047h 71 HI

Fixed value for For-
mula source 2-3

0048h 72 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0049h 73 HI

Fixed value for For-
mula source 2-4

004Ah 74 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
004Bh 75 HI

Fixed value for For-
mula source 2-5

004Ch 76 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
004Dh 77 HI

Operator 2-1 004Eh 78 0 0= + 1= - 2= * 3=÷
Operator 2-2 004Fh 79 0 0= + 1= - 2= * 3=÷
Operator 2-3 0050h 80 0 0= + 1= - 2= * 3=÷
Operator 2-4 0051h 81 0 0= + 1= - 2= * 3=÷
 Formula source 3-1 0052h 82 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 3-1

 Formula source 3-2 0053h 83 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 3-2

 Formula source 3-3 0054h 84 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 3-3

 Formula source 3-4 0055h 85 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 3-4

 Formula source 3-5 0056h 86 0 0= None 1=A 2=B 3= Receiving data 1 4= Receiving data 2 5= Fixed value 3-5

Reserved 0057h 87
Fixed value for For-
mula source 3-1

0058h 88 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0059h 89 HI

Fixed value for For-
mula source 3-2

005Ah 90 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
005Bh 91 HI

Fixed value for For-
mula source 3-3

005Ch 92 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
005Dh 93 HI

Fixed value for For-
mula source 3-4

005Eh 94 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
005Fh 95 HI

Fixed value for For-
mula source 3-5

0060h 96 0 LOW 080000000 h (-2147483648) ~ 7FFFFFFFh (2147483647)
0061h 97 HI

Operator 3-1 0062h 98 0 0= + 1= - 2= * 3=÷
Operator 3-2 0063h 99 0 0= + 1= - 2= * 3=÷
Operator 3-3 0064h 100 0 0= + 1= - 2= * 3=÷
Operator 3-4 0065h 101 0 0= + 1= - 2= * 3=÷
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UQ1 has 5 control outputs, Q1~Q5, in the unit that judge measured result OK or NG.
Each control output has Source and Hold mode to set.

 ●Q1 ~ Q5 source
Specify the source of each control output.
[Parameters]

0: Head A
1: Head B
2: Formula 1
3: Formula 2
4: Formula 3
5: Receiving data 1
6: Receiving data 2
7: None

 ●Q1 ~ Q5 Hold
Specify Hold mode for judging Q1~Q5.
[Parameters]

0: Hond None
1: Sample Hold
2: Peak Hold
3: Bottom Hold
4: Peak to Peak Hold
5: Average Hold (doesn’t work when it’s High speed mode)

 ● Formula 1 ~ 3
Specify formula for the calculation. It can be source of Q1~Q5.

Formula
Source

Operator

1 1 2 2 3 3 4 4 5
Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source

 ● Formula source (1~5)
Specify source of the formula.
[Parameters]

0: None
1: Measurement result of Head A
2: Measurement result of Head B
3: Receiving data 1 (FIrST transmit data 1 from next unit)
4: Receiving data 2 (FIrST transmit data 2 from next unit)
5: Fixed value

 ●Operator
Specify operator of the formula.
You can use “+: addition”, “-: subtraction”, “*: multiplication” and “÷: division”.
[Parameters]

0: +
1: -
2: *
3: ÷
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 ● Example of Formula setup
Actual formula is as following.

Calculation of thickness

Because the distance between two sensor heads is fi xed, the object thickness is calculated by t=(A+B)+L. 
Please set "L" by calibration using a gauge.

B

A

t
L

Head A

Head B

Head A center
stand off

Head B center
stand off

For example, when the thickness of the object is 10mm and "A+B" is 9.2mm, set the formula as fol-

lows. Set the "Fixed value" as "0.800" (L=t-A-B   then   10mm - 9.2mm = 0.8mm).

Head A + 0.800 + - + -Head B +

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source

Calculation of step height

Height of the step from the base is calculated by “H=A-B”.

B
A

H

Head A Head B

Formula for calculation of step height is as follows.

－ + - + -+ -Head A Head B

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source
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Calculation of inclination

Inclination is calculated with distance between sensor heads (Fixed value “L”).
The formula is as follows.

θ= tan-1 A - B
L

Approximation
θ= (A - B) / L

H

Head A Head B

B
A

When the distance between two sensor heads is 80mm for example, the formula is as follows.

－ 80.00 + - + -÷Head A Head B

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source

Getting measured data from adjoining unit

The measured data from adjoining unit is treated as “Receiving data 1, 2”.
The data is transmitted from adjoining unit at slave side. Setup should be done at the slave unit. Please 
refer “2.1.1  FIrST communication”.

For example, when calculating average
of two Head A connected to each UQ1 unit,
setup is as follows.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

UQ1 unit 1
(master side)

UQ1 unit 2
(slave side)

Transmit data 
setup is done 
at slave side.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

FIrST

- UQ1 unit 1 (master side)
Setup the formula as follows.

＋ 2.000 + - + -÷Head A Receiving 
data 1

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source
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- UQ1 unit 2 (slave side)
Setup as follows.
FIrST transmit data 1 setup (shared memory address 109): 0 (Head A)

Tips
• Process time will be longer when you use calculation.

You can shorten the process time by making calculation not needed inactive setting "Trigger IN 
Calculation 1, 2, 3" (Y0C, Y0D, Y0E) as ON.

• When you use "*" or "÷" for the operator, process time will be longer.
• FIrST communication will be done every UQ1 updating timing.

When FIrST communication is done with multiple UQ1 units, the communication delays for to-
tal cycle of updating period.
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Getting data from the unit not adjoining

For example, when you use 3 UQ1 units connected as following picture, the data from unit 3 can be trans-
ferred to unit 1 through unit 2. Unit 1 can’t get the data from unit 3 directly.

When you calculate step height using two
Head A connected to unit 1 and unit 3, setup
should be done as following.
In this example case, Formula 3 of unit 2 is
used to assign Receiving data 1 as FIrST
Transmit data 1.
Although, you can use Formula 1 or 2 as well.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

UQ1
Unit 1

UQ1
Unit 2

UQ1
Unit 3

Formula 1

Formula 2

Formula 3

- UQ1 unit 1 (master)
Set the Formula as follows.

－ + - + -＋ -Head A Receiving 
data 1

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source

- UQ1 unit 2 (center unit)
Set the Formula and FIrST Transmit data 1 as follows.

＋ + - + -＋ --Receiving 
data 1

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source

FIrST Transmit data 1 (shared memory address 109): 4 (Formula 3)

- UQ1 unit 3 (slave side)
Setup as follows.
FIrST Transmit data 1 (shared memory address 109): 0 (Head A)
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3.2.4  Setup of other parameters (Etc.)
Item

Address
Default Parameters

Hex. Decimal

E
tc

.

Bank number 0066h 102 0 0 ~ 59 = Bank 0 ~ 59
Hold mode 0067h 103 0 0 = Auto (data clear when RESET) 1 = Normal (data clear when sampling starts)
Hysteresis 0068h 104 0 LOW 0 ~ 7FFFFFFFh (2147483647) 

0069h 105 HI

 ●Bank number
Up to 60 threshold level of Q1~Q5 can be stored in the UQ1 unit.
Following threshold and offset are stored in the Bank.

- Q1~Q5 Upper/Lower threshold (shared memory address 128~147)
- Q1~Q5 Offset (shared memory address 148~157)

Over writing Bank setup

You can over write Bank setup parameters by following procedure.
<1> Set Bank number to over write into “Bank number” (shared memory address 102)
<2> Setup “Bank setup parameters” (shared memory address 128~159).
<3> Set Y11: “Over writing Bank setup” ON.

While over writing Bank setup, X11 BUSY will be ON and accessing to shared memory stops.

Switching Bank

You can switch the Bank loading setup parameters by following procedure.
<1> Set Bank number to switch to into “Bank number” (shared memory address 102)
<2> Set Y08: “Switching Bank” ON.

While switching the Bank, X12 BUSY will be ON and accessing to shared memory stops.

 ●Hold mode
Specify process of Hold mode.
Please refer [3.3  Hold mode and process] in detail.

0: Auto Hold mode
- Update data while measuring
- Update data when the trigger is ON
- Clear the data when RESET is ON

1: Normal Hold mode
- While sampling, trigger is OFF, it doesn’t refl ect to the level.
- At the up edge of the trigger, it refl ect to the level and fi x.
- While sampling, trigger is OFF, it update the level internally.
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 ●Hysteresis
Specify hysteresis as the distance between the level that Q1~Q5 turns ON and the level that Q1~Q5 goes 
OFF after turning ON. The unit is 0.01μm
In the following example, Qx turns ON at A point there the level exceeds upper threshold. Then, Qx goes 
OFF at B point there the level goes under “Upper threshold - Hysteresis”.

This feature helps stabilizing the output when the level fl uctuates around the threshold level.
Qx doesn’t turn ON unless the level exceeds the threshold so Qx doesn’t turn ON at D point there the level 
just exceeds “Upper threshold - Hysteresis”.

Qx Upper
threshold

Qx

Hysteresis

A B

C
D
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3.2.5  Input / Output setup
Item

Address
Default Parameters

Hex. Decimal

O
ut

pu
t s

et
up

On delay 006Ah 106 0 0= None 1 ~ 0FFFFh (65535) ms * Refl ect to Signal Out 1, 2 , X device
Off delay 006Bh 107 0 0= None 1 ~ 0FFFFh (65535) ms * Refl ect to Signal Out 1, 2 , X device
One shot 006Ch 108 0 0=OFF 1=ON * Refl ect to Signal Out 1, 2 , X device
FIrST Transmit data 1 setup 006Dh 109 0 0= Head A 1= Head B 2= Formula 1 3= Formula 2 4=Formula 3 5= None
FIrST Transmit data 1 Hold 006Eh 110 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 

Peak
5= Average

FIrST Transmit data 2 setup 006Fh 111 1 0= Head A 1= Head B 2= Formula 1 3= Formula 2 4=Formula 3 5= None
FIrST Transmit data 2 Hold 0070h 112 0 0= None 1= Sample 2= Peak 3= Bottom 4= Peak to 

Peak
5= Average

Signal Out  1 0071h 113 0 0=Q1 1=Q2 2=Q3 3=Q4 4=Q5 * ON when out side of threshold
Signal Out  2 0072h 114 1 0=Q1 1=Q2 2=Q3 3=Q4 4=Q5 * ON when out side of threshold
Signal Out logic 0073h 115 0 0= All nor-

mal
1=1 is 
reverse

2=2 is
reverse

3= All reverse

In
pu

t s
et

up Trigger timing of data sam-
pling

0074h 116 0 0= OFF 1= ON 2= Up edge 3= Down edge * RESET effects at up 
edge only

Trigger IN 1 0075h 117 0 0= RESET 1= Head A 2= Head B 3= Formula 1 4=Formula 2 5=Formula 3
Trigger IN 2 0076h 118 1 0= RESET 1= Head A 2= Head B 3= Formula 1 4=Formula 2 5=Formula 3

Setup parameters regarding Input and Output.

 ●ON delay / OFF delay
Specify the delay time of output turning ON and OFF. The unit is msec.
When the width of ON or OFF time of measured result is shorter than ON delay or OFF delay like “A” and “B” 
in the following chart. ON delay and OFF delay affect all output.

Measured 
result

Qx

ON delay OFF delay
A B

 ●One shot
Specify if output as one shot or not.
When One shot is ON, the output will be ON for the period specifi ed by OFF delay.
One shot affects all output.

Measured 
result

Qx

OFF delay
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 ● FIrST Transmit data 1/2 setup, FIrST Transmit data 1/2 hold
Specify the source to send through FIrST to another UQ1 unit at master side.
The data sent from slave side will be assigned as “Receiving data 1/2” in the unit.
Please refer [2.1.1  FIrST communication]
At “FIrST Transmit data 1/2 hold”, specify the hold mode of the data to transmit.
Please refer [3.3 Hold mode and process]

 ● Signal Out 1/2
Specify the source to output from “Signal Out 1/2” at terminal block.
The indicator LED “OUT 1/2” will be ON when the output is ON.
[Parameters]

0: Q1
1: Q2
2: Q3
3: Q4
4: Q5

 ● Signal out logic
Specify the logic of the “Signal Out 1/2”.
[Parameters]

0: Normal (ON when the measurement result is out of threshold)
1: The logic of Signal out 1 is reverse (ON when the measurement result is in the threshold)
2: The logic of Signal out 2 is reverse (ON when the measurement result is in the threshold)
3: The logic of Signal out 1 and 2 is reverse (ON when the measurement result is in the threshold)

 ● Trigger timing of data sampling
Specify the timing of “Trigger IN” to sample the data.
When “RESET” is assigned for Trigger IN 1 or 2, the timing is up edge.
[Parameters]

0: OFF (when Trigger IN is OFF, it samples the data)
1: ON (when Trigger IN is ON, it samples the data)
2: Up edge (at the up edge of Trigger IN, it samples the data)
3: Down edge (at the down edge of Trigger IN, it samples the data)

 ● Trigger IN 1/2
Specify the source of “Trigger IN 1/2”.
The indicator LED “IN 1/2” will be ON when the input is ON.
[Parameters]

0: RESET   (Y09)
1: Head A    (Y0A)
2: Head B     (Y0B)
3: Formula 1  (Y0C)
4: Formula 2  (Y0D)

5: Formula 3  (Y0E)
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3.2.6   Storage setup
Item

Address
Default Parameters

Hex. Decimal
Data store skip number 0077h 119 0=No skip 1 ~ 0FFFFh (65535)
Source of data 0078h 120 0 0=Q1 1=Q2 2=Q3 3=Q4 4=Q5 5= Head A 6= Head B 7= Formula 1

8= Formula 2 9= Formula 3 * Q1~Q5 will be added its offset.
Hold mode 0079h 121 0 0= None 1= Sample 2= Peak 3=Bottom 4= Peak to 

Peak
5=Average * Effective when the source 

of data is Head A ~ Formula 3 
(5~9)

Pointer clear timing 007Ah 122 1 0=When trigger is ON 1=When RESET is ON
Pointer end control 007Bh 123 1 0=Stop 1=Continue 

from start
Storage transfer start 
pointer

007Ch 124 0 LOW Start pointer number (0 ~ 245928) of the internal storage memory for transferring to shared memory. 
262144 (14Eh~7FFDh) totally (every 16216). This is effective immediately after updating.007Dh 125 HI

Following shows about storage function.
Measured data will be stored regarding to related parameters set. You can transfer the data from storage into 
shared memory after the measurement.

 ●UQ1 data access for storage
UQ1 has internal memory for storage besides
the shared memory.
Measurement data will be stored into the
internal memory fi rstly.
To refer the measurement data, please
proceed following procedure.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

Internal memory Shared memory
(can be referred)

Stored data
(address:
 334~32765)

Procedure of getting data transfered to shared memory

1)  Storage setup
Setup parameters related to storage of measurement data.
Please refer [1.2.2  UQ1 series data fl ow] about how to over write shared memory.

2)  Getting measurement data from CD5 sensor head into internal memory for storage
UQ1 unit gets the measurement
data from CD5 and store into internal
memory for storage regarding
the setup.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA
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Tips
Maximum number of data can be stored into the internal memory is 262144 (word).
When the pointer of the memory exceeds end of the memory, it proceeds according to "Pointer end 
control" (shared memory address: 123) setup.

3) Get the data transferred
The measurement data can be referred after transferring the data from the storage memory into 
shared memory. The start pointer of the storage is specifi ed by “Storage transfer start pointer” (shared 
memory address: 124~125).
You can check current pointer of the storage at “Storage current pointer” (shared memory address: 
328).
* Over writing by Y10 “Over writing common setup” is not needed.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

POWER 
MODE 

RUN 
ERR.

USER 
BAT.

PULL

MITSUBISH I

Q00XXCPU

PULL

Specify the start pointer

The measurement data will be transferred by setting Y0F “Getting data stored”.
While transferring data, X13 “BUSY Getting data sored” will be ON and stop measurement.
After transferring data to shared memory, the data can be referred by sequencer.
You can transfer the data more than 16216 word changing the pointer.

UQ1-01
JUDGE
ERR.
HEAD A
HAED B

1  2  3  4  5

<<NEAR FAR>>

  IN   1   2
OUT 1   2

LNK

CD5
HEAD

SDA

RDA

SDA

RDA

A

(SG)

SDB

RDB

SDB

RDB

B

A

B

SYC OUT

1
SIG OUT

2

1
TRG IN

2

12VDC

COM

+

-

0

1

2

3

4

5
6

7

8

9

A

B

C

D

E

F
24VDC
80mA

POWER 
MODE 

RUN 
ERR.

USER 
BAT.

PULL

MITSUBISH I

Q00XXCPU

PULL

The data will be transferred by 
setting Y0F "Getting data stored"
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 ●Data store skip number
Specify the number to skip when storing data from CD5 sensor head to the storage memory.
After storing one data, it skips the number of data specifi ed before next storing.
When “0” is set, all the data will be stored.

Example:  Store one data while sampling 10 times.
Data store skip number: 9
When UQ1 update period is 100μs: 0.1ms * 10 = 1ms (store one data every 1ms)
When UQ1 update period is 3200μs: 3.2ms * 10 = 32ms (store one data every 32ms)

 ● Source of data
Specify the source of data to store.
When Q1~Q5 is chosen, its offset will be added before storing.
[Parameters]

0: Q1
1: Q2
2: Q3
3: Q4
4: Q5
5: Head A
6: Head B
7: Formula 1
8: Formula 2
9: Formula 3

 ●Hold mode
Specify the hold mode of the source of data.
Effective when the source of data is Head A/B, Formula 1/2/3 (shared memory address 120 is 5~9).
[Parameters]

0: None
1: Sample
2: Peak
3: Bottom
4: Peak to Peak
5: Average

 ● Storage of 2 measurement result (UQ1-02)
You can store 2 measurement result with UQ1-02 at a time.
Maximum number of the data is 131071 (1FFFFh) for each measurement result.
Setup as follows.
Item Address Parameters

Hex. Decimal 1000h 100h 10h 1h
Source of data 0078h 120 0 (2nd parameter) 1 (1st parameter)
Hold mode 0079h 121 0 (2nd parameter) 0 (1st parameter)

"Storage current pointer" (shared memory 328, 329) shows 1st pointer.
2nd pointer is "Storage current pointer" + 131072 (20000h).
Example: "Source of data": 1st Q2, 2nd Q3  →  1 + 10h(16) +( 2 * 100h(256)) = 211h(529)
Example: "Hold mode": 1st Peak, 2nd Bottom  →  2 +( 3 * 100h(256)) = 302h(770)
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Tips
UQ1-01 later version than 2 support storing 2 measurement result.
You can confi rm the version on the label.
There is version number above the "CE" mark.
With no version shown as following picture it's version 1.

If you proceed storing 2 measurement result with UQ1 of version 1, it will store only one measure-
ment result of Q1 with Hold mode: "None".

 ● Pointer clear timing
Specify the timing to clear the pointer.
- When the Trigger is ON

When the trigger is ON, when storing starts, the pointer is cleared.
- When the RESET is ON

When Y09 “RESET” is ON, the pointer is cleared.
When the trigger is ON, it continues storing new data increasing the pointer.

[Parameters]
0: Trigger is ON
1: RESET is ON

 ● Pointer end control
Specify the process of the pointer when the pointer reaches end of the storage memory.
[Parameters]

0: Stop  (stops storing measurement data)
1: Continue from start  (clear the pointer and continue storing the data)

 ● Storage transfer start pointer
Specify start pointer of storage memory (0~245928) for transferring to shared memory.
It affects immediately right after setting this parameter (no need setting Y10 “Over writing common setup”). 
Data is stored being numbered from 0.
When the pointer is specified, 16216 data will be transferred to “Loaded data” (shared memory address 
14Eh~7FFDh) from the address pointed by the pointer.

0~245928: Storage transfer start pointer

Tips
When set start pointer as bigger than 245928, data over 262144 will be stored from 0.
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3.2.7 Initializing

Item
Address

Default Parameters
Hex. Decimal

Initialize 007Fh 127 0101h * Initialize by rebooting after setting this parameter “0”and Y10 as “1”.

Initialize all setup parameters to default.
Initializing procedure is as follows.

<1> Set Initialize (shared memory address 127) as “0”
<2> Activate Y10 Over writing common setup
<3> After confi rming X10 BUSY: Over writing common setup is OFF, shut down the power supply
 and re-power.

3.2.8  Bank setup

Item
Address

Default Parameters
Hex. Decimal

Th
re

sh
ol

d 
/ O

ffs
et

Q1 Upper threshold 0080h 128 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0081h 129 HI

Q1 Lower threshold 0082h 130 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0083h 131 HI

Q2 Upper threshold 0084h 132 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0085h 133 HI

Q2 Lower threshold 0086h 134 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0087h 135 HI

Q3 Upper threshold 0088h 136 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0089h 137 HI

Q3 Lower threshold 008Ah 138 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)008Bh 139 HI

Q4 Upper threshold 008Ch 140 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)008Dh 141 HI

Q4 Lower threshold 008Eh 142 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)008Fh 143 HI

Q5 Upper threshold 0090h 144 47868C0h 
(75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0091h 145 HI

Q5 Lower threshold 0092h 146 0FB879740h 
(-75000000)

LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
 (Offset is refl ected)0093h 147 HI

Q1 Offset 0094h 148 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
0095h 149 HI

Q2 Offset 0096h 150 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
0097h 151 HI

Q3 Offset 0098h 152 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
0099h 153 HI

Q4 Offset 009Ah 154 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
009Bh 155 HI

Q5 Offset 009Ch 156 0 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647)
009Dh 157 HI

Reserved 009Eh 158
Reserved 009Fh 159

Setup parameters for each Bank.

 ●Q1 ~ Q5  Upper threshold, Q1 ~ Q5  Lower threshold
Specify threshold of Q1 ~ Q5.
Judge (OK or NG) will be done for each value including its offset.

 ●Offset Q1 ~ Q5
Specify offset value for each Q1 ~ Q5.
When Y00 ~ Y04 Zero reset for Q1 ~ Q5 is ON, offset of corresponding Qx will be adjusted so that the Qx to 
be “0”.
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3.2.9  Q1 ~ Q5 result

Item
Address

Default Parameters
Hex. Decimal

Q
1 

~ 
Q

5 
re

su
lt

Q1 00A0h 160 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A1h 161 HI

Q2 00A2h 162 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A3h 163 HI

Q3 00A4h 164 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A5h 165 HI

Q4 00A6h 166 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A7h 167 HI

Q5 00A8h 168 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 (Offset is refl ected)00A9h 169 HI

 ●Q1 ~ Q5 result
Q1 ~ Q5 will be used for Signal out 1/2.
Q1 ~ Q5 is its source (Head or Formula or Receiving data) + its offset.

Item
Address

Default Parameters
Hex. Decimal

C
en

te
r s

ta
nd

 o
ff

Head A Center stand off 00AAh 170 Fixed 
value by 
type

LOW 2500000(25mm) ~ 200000000  (2000mm)
00ABh 171 HI

Head B Center stand off 00ACh 172 Fixed 
value by 
type

LOW 2500000(25mm) ~ 200000000  (2000mm)
00ADh 173 HI

Reserved 00AEh 174
Reserved 00AFh 175

 ●Head A/B Center stand off
Center stand off will be set automatically recognizing connected CD5 sensor type.
This value will be utilized for reference as absolute center stand off.
Example:  85.000mm for CD5-85
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Item
Address

Default Parameters
Hex. Decimal

M
ea

su
re

m
en

t r
es

ul
t

Head A 00B0h 176 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00B1h 177 HI

Head A Sample Hold 00B2h 178 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00B3h 179 HI

Head A Auto Peak hold 00B4h 180 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00B5h 181 HI

Head A Peak Hold 00B6h 182 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00B7h 183 HI

Head A Auto Bottom Hold 00B8h 184 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00B9h 185 HI

Head A Bottom Hold 00BAh 186 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00BBh 187 HI

Head A Auto Peak to Peak 
Hold

00BCh 188 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00BDh 189 HI

Head A Peak to Peak Hold 00BEh 190 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00BFh 191 HI

Head A Auto Average Hold 00C0h 192 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C1h 193 HI

Head A Average Hold 00C2h 194 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C3h 195 HI

Head A Count 00C4h 196 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C5h 197 HI

Head B 00C6h 198 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00C7h 199 HI

Head B Sample Hold 00C8h 200 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00C9h 201 HI

Head B Auto Peak hold 00CAh 202 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00CBh 203 HI

Head B Peak Hold 00CCh 204 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00CDh 205 HI

Head B Auto Bottom Hold 00CEh 206 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00CFh 207 HI

Head B Bottom Hold 00D0h 208 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D1h 209 HI

Head B Auto Peak to Peak 
Hold

00D2h 210 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D3h 211 HI

Head B Peak to Peak Hold 00D4h 212 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D5h 213 HI

Head B Auto Average Hold 00D6h 214 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D7h 215 HI

Head B Average Hold 00D8h 216 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00D9h 217 HI

Head B Count 00DAh 218 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00DBh 219 HI

Formula 1 00DCh 220 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00DDh 221 HI

Formula 1 Sample Hold 00DEh 222 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00DFh 223 HI

Formula 1 Auto Peak Hold 00E0h 224 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E1h 225 HI

Formula 1 Peak Hold 00E2h 226 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E3h 227 HI

Formula 1 Auto Bottom Hold 00E4h 228 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E5h 229 HI

Formula 1 Bottom Hold 00E6h 230 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E7h 231 HI

Formula 1 Auto Peak to Peak 
Hold

00E8h 232 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00E9h 233 HI

Formula 1 Peak to Peak Hold 00EAh 234 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00EBh 235 HI

Formula 1 Auto Average Hold 00ECh 236 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00EDh 237 HI

Formula 1 Average Hold 00EEh 238 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00EFh 239 HI

Formula 1 Count 00F0h 240 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F1h 241 HI

Formula 2 00F2h 242 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
00F3h 243 HI

Formula 2 Sample Hold 00F4h 244 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F5h 245 HI

Formula 2 Auto Peak Hold 00F6h 246 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F7h 247 HI

Formula 2 Peak Hold 00F8h 248 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00F9h 249 HI

Formula 2 Auto Bottom Hold 00FAh 250 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00FBh 251 HI

Formula 2 Bottom Hold 00FCh 252 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00FDh 253 HI

Formula 2 Auto Peak to Peak 
Hold

00FEh 254 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”00FFh 255 HI
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Item
Address

Default Parameters
Hex. Decimal

M
ea

su
re

m
en

t r
es

ul
t

Formula 2 Peak to Peak Hold 0100h 256 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0101h 257 HI

Formula 2 Auto Average Hold 0102h 258 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0103h 259 HI

Formula 2 Average Hold 0104h 260 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0105h 261 HI

Formula 2 Count 0106h 262 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0107h 263 HI

Formula 3 0108h 264 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0109h 265 HI

Formula 3 Sample Hold 010Ah 266 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”010Bh 267 HI

Formula 3 Auto Peak Hold 010Ch 268 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”010Dh 269 HI

Formula 3 Peak Hold 010Eh 270 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”010Fh 271 HI

Formula 3 Auto Bottom Hold 0110h 272 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0111h 273 HI

Formula 3 Bottom Hold 0112h 274 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0113h 275 HI

Formula 3 Auto Peak to Peak 
Hold

0114h 276 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0115h 277 HI

Formula 3 Peak to Peak Hold 0116h 278 LOW 0 ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0117h 279 HI

Formula 3 Auto Average Hold 0118h 280 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”0119h 281 HI

Formula 3 Average Hold 011Ah 282 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”011Bh 283 HI

Formula 3 Count 011Ch 284 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
 set by “Pointer clear timing”011Dh 285 HI

Receiving data 1 011Eh 286 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
011Fh 287 HI

Receiving data 2 0120h 288 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0121h 289 HI

Reserved 0122h 290
Reserved 0123h 291
Reserved 0124h 292
Reserved 0125h 293
Reserved 0126h 294
Reserved 0127h 295

 ●Measurement result
Measurement result will be set.
Measurement result is updated every updating period of UQ1 regardless of setup of Q1 ~ Q5.

Its process while the trigger is OFF depends on setup of “Hold mode” (shared memory address 103).
When Y09 RESET is ON, the value will be reset.

-0 (Auto mode): When the trigger is OFF, the value will be reset
-1 (Hold mode): The value won’t be reset when the trigger is OFF

Tips
Offset value won't be added on the measurement result.

The data from the slave UQ1 unit through FIrST will be set to “Receiving data”. Please refer [2.1.1  FIrST 
communication].

Tips
• The receiving data to be set at slave side unit.
• When the communication data is not available or the data is broken, "0" will be set.
• When "High speed mode" (shared memory address 31) is ON, "Average" and "Average Hold" will 

be set "0".
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Item
Address

Default Parameters
Hex. Decimal

E
le

m
en

t o
f F

or
m

ul
a

Element 1 of Formula 1 0128h 296 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0129h 297 HI

Element 2 of Formula 1 012Ah 298 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
012Bh 299 HI

Element 3 of Formula 1 012Ch 300 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
012Dh 301 HI

Element 1 of Formula 2 012Eh 302 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
012Fh 303 HI

Element 2 of Formula 2 0130h 304 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0131h 305 HI

Element 3 of Formula 2 0132h 306 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0133h 307 HI

Element 1 of Formula 3 0134h 308 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0135h 309 HI

Element 2 of Formula 3 0136h 310 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0137h 311 HI

Element 3 of Formula 3 0138h 312 LOW 080000000h  (-2147483648) ~ 7FFFFFFFh  (2147483647) 
0139h 313 HI

Reserved 013Ah 314
Reserved 013Bh 315
Reserved 013Ch 316
Reserved 013Dh 317
Reserved 013Eh 318
Reserved 013Fh 319

 ●Calculation element
Result of each formula element will be set.
Element 1 ~ 3 are calculation result of formula element as follows.

1 1 2 2 3 3 4 4 5

Element 1 Element 2

Element 3

Formula
Source

Operator Operator Operator Operator

Formula
Source

Formula
Source

Formula
Source

Formula
Source
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3.2.10  Error status
Item

Address
Default Parameters

Hex. Decimal
Calculation Overfl ow Formula 

1
0140h 320 0 B0= Element 1 B1= Element 2 B2= Element 3 B3= Formula 1

Formula 
2

B4= Element 1 B5= Element 2 B6= Element 3 B7= Formula 2

Formula 
3

B8= Element 1 B9= Element 2 B10= Element 3 B11= Formula 3

Head A B12= Out of range Alarm
Head B B13= Out of range Alarm

Reserve 0141h 321
Reserve 0142h 322
Reserve 0143h 323

 ●Calculation Overfl ow
When the calculation result overfl ows, the corresponding bit will be “1”.
These bits won’t be cleared even the overfl ow is released.
Please proceed one of following procedures to clear the bits.

- Reboot the power supply
- Set Y09 RESET ON
- Set Y16 Error release ON

B0:  Element 1 of Formula 1
B1:  Element 2 of Formula 1
B2:  Element 3 of Formula 1
B3:  Formula 1
B4:  Element 1 of Formula 2
B5:  Element 2 of Formula 2
B6:  Element 3 of Formula 2
B7:  Formula 2
B8:  Element 1 of Formula 3
B9:  Element 2 of Formula 3
B10: Element 3 of Formula 3
B11:  Formula 3
B12:  Head A is out of range
B13:  Head B is out of range



3-42

Parameters in detail

3.2.11  Unit status
Item

Address
Default Parameters

Hex. Decimal
Current Bank number 0144h 324 0 0 ~ 59  =  Bank 0 ~ 59
Version 0145h 325 Version
Q1~Q5 and source status 0146h 326 0 B0= Head A B1= Head B B2=Formula 

1
B3=Formula 
2

B4=Formula 
3

B5= Receiv-
ing data 1

B6= Receiv-
ing data 2

B11=Q1 B12=Q2 B13=Q3 B14=Q4 B15=Q5
Response speed (μs) 0147h 327
Storage current pointer 0148h 328 0 LOW 0 ~ 262143  (When the pointer reaches end and "Pointer end control" is 0=Stop, it will stop at 

262143. When "Pointer end control" is 1= Continue from start, it restarts from 0.)0149h 329 HI
Storage overfl ow 014Ah 330 0 0= Pointer is less than 

262143
1= Overfl ow

Reserved 014Bh 331
Reserved 014Ch 332
Reserved 014Dh 333

Shows if these resources are used or not.

 ●Current Bank number
Shows the number of the Bank currently set.

 ● Version
Shows unit version.

 ●Q1 ~ Q5 and source status
Shows which Qx and its source are used on each bit.

B0: Head A
B1: Head B
B2: Formula 1
B3: Formula 2  When these are assigned at Q1 ~ Q5, the bit will be ON.
B4: Formula 3
B5: Receiving data 1
B6: Receiving data 2

B11: Q1
B12: Q2
B13: Q3
B14: Q4
B15: Q5

 ●Response speed
Shows response speed of UQ1 unit in μs.
Updating data in the UQ1 unit will be done every 100μs that rounded out the hundred’s place of actual pro-
cess time. For example, when the actual process time is 140 μs, it’s 200μs.

- When updating time of UQ1 > Sampling period of CD5:
    UQ1 acquires data every its updating period so it won’t be able to acquire every data.
    Example) Updating period of UQ1: 400μs, Sampling period of CD5: 200μs;
   UQ1 will skip acquisition of data every 2.
- When updating time of UQ1 < Sampling period of CD5:
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    There will be no updated data from CD5/CD33 intermittently.
    When there is no updated data from CD5/CD33, UQ1 unit will use previous data internally.

Tips
You can shorten process time by following setup.
• Not use Formula

The more Formula are used, the longer process time it will spend.
You can shorten process time by deleting Formula that are not needed.

• Not use operator "*" and "÷".
These operators will take time to calculate.
You can shorten process time by not using these operator.

• Use "High speed mode"
You can shorten process time by set "High speed mode" shared memory address 31 ON.
In this case, you can't use "Average Hold" and "Auto Average Hold".

Storage current pointer

Shows current pointer of storage
0 ~ 262143 : Current pointer
(When the pointer reaches end and “Pointer end control” is 0=Stop, it will stop at 262143. When “Pointer 
end control” is 1= Continue from start, it restarts from 0.)

 ● Storage overfl ow
This is a fl ag that shows if overfl ow occured or not in storage.

3.2.12 Loaded data
Item

Address
Default Parameters

Hex. Decimal
1st Depends on "Source of data" 

address 120
014Eh 334 LOW Depends on "Source of data" address 120
014Fh 335 HI

~ ~
16199
th

Depends on "Source of data" 
address 120

7FFCh 32766 LOW Depends on "Source of data" address 120
7FFDh 32767 HI

The data will be loaded from storage.

Please refer [3.2.6  Storage setup] for in detail.
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3.2.13   Waveform data
When Y14, Y15 Head A/B Waveform mode is ON, shared memory address 334 ~ 1357 will be updated with 
Waveform data continuously.

Item Address Default Parameters
Hex. Decimal

Waveform data

Head A Threshold level 014Eh 334 0 ~ 255  (0FFh): UQ1-01
0 ~ 4095 (0FFFh): UQ1-02
65535 (0FFFFh): UQ1-02 (non applicable sensor head)

Peak position 1 014Fh 335 0 ~ 511  (01FFh)
Peak position 2 0150h 336 0 ~ 511  (01FFh)
Waveform data 1 0151h 337 0 ~ 255  (0FFh)
~ ~
Waveform data 480 (UQ1-01 end of data) 0331h 817 0 ~ 255  (0FFh)
Waveform data 508 (UQ1-02 end of data) 034Dh 845 0 ~ 4095  (0FFFh)

Head B Threshold level 034Eh 846 0 ~ 255  (0FFh): UQ1-01
0 ~ 4095 (0FFFh): UQ1-02
65535 (0FFFFh): UQ1-02 (non applicable sensor head)

Peak position 1 034Fh 847 0 ~ 511  (01FFh)
Peak position 2 0350h 848 0 ~ 511  (01FFh)
Waveform data 1 0351h 849 0 ~ 255  (0FFh)
~ ~
Waveform data 480 (UQ1-01 end of data) 0531h 1329 0 ~ 255  (0FFh)
Waveform data 508 (UQ1-02 end of data) 054Dh 1357 0 ~ 4095  (0FFFh)

 ● Threshold
Shows threshold level to detect peak from Waveform data. The level depends on “Threshold for detecting 
peak” shared memory address 4, 18.

 ● Peak position 1 / 2
Shows peak position of the Waveform data in CD5 sensor head.

 ●Waveform data
Shows Waveform data.
Following graph shows Waveform data visually. The position “0” means it’s near side of the sensor head.
Maximum light level of UQ1-02 is 4095 though, it will be less than 2047 normally.

0 480

Light
level

Position

Peak position 1 Peak position 2

Threshold

Distribution 

480：UQ1-01
512：UQ1-02
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 ● Timing chart while Waveform mode
X/Y devices regarding "Head A/B monitoring mode" are as following timing chart while switching the mode. 
Please don't change Y14/15 "Head A/B Waveform mode" while X14/15 "BUSY" is ON.

Y14/Y15

X14/X15

Mode

50ms or morearound 10ms around 10ms

Measurement Distribution 
mode

Measurement
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3.3   Hold mode and process
Sampling process of UQ1 will be determined by “Q1 ~ Q5 Hold” and “Hold mode”.
Following time charts show how each mode works.

Parameters not specifi ed in each hold mode explanation are as follows.
- Trigger timing of data sampling: 0 (OFF)
- ON delay / OFF delay / One shot: None
- Signal Out logic: 0 (normal)

Tips
• Trigger for Head A/B and Calculation 1/2/3 is made by Trigger IN (terminal input) or Y0A ~ Y0E.
• Trigger input assignment is specifi ed by "Trigger IN 1/2" (shared memory address 117/118).

 ●No Hold
- Qx Hold: 0  (No Hold)
- Hold mode: 0/1  (doesn’t affect)

It doesn’t do Hold process. While Trigger input is ON, it keeps the level at just before the Trigger input 
is ON.
Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ● Sample Hold
- Qx Hold: 1 (Sample Hold)
- Hold mode: 0/1 (doesn’t affect)

It samples and hold at up edge of Trigger input. Effective for sampling the level at a point.

Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ● Peak Hold
- Qx Hold: 2 (Peak Hold)
- Qx Hold: 2 (Peak Hold)

It outputs maximum level sampled while the sampling period.

Dotted line means original measured value. Full line means output.

Sampling period

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ● Auto Peak Hold
- Qx Hold: 2 (Peak Hold)
- Hold mode: 0 (Auto)

While the Trigger input is OFF, it outputs and keeps maximum level.
While the Trigger input is ON, it keeps the level sampled at up edge of the trigger input.

Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ●Bottom Hold
- Qx Hold: 3 (Bottom Hold)
- Hold mode: 1 (Normal)

It outputs minimum level sampled while the sampling period.

Dotted line means original measured value. Full line means output.

Sampling period

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ●Auto Bottom Hold
- Qx Hold: 3 (Bottom Hold)
- Hold mode: 0 (Auto)

While the Trigger input is OFF, it outputs and keeps minimum level.
While the Trigger input is ON, it keeps the level sampled at up edge of the trigger input.

Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ● Peak to Peak Hold
- Qx Hold: 4 (Peak to Peak Hold)
- Hold mode: 1 (Normal)

It outputs peak to peak (maximum - minimum) level sampled while the sampling period.

Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648
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 ●Auto Peak to Peak Hold
- Qx Hold: 4 (Peak to Peak Hold)
- Hold mode: 0 (Auto)

While the Trigger input is OFF, it outputs and keeps peak to peak (maximum - minimum) level.
While the Trigger input is ON, it keeps the level sampled at up edge of the trigger input.

Dotted line means original measured value. Full line means output.
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 ●Average Hold
- Qx Hold: 5 (Average Hold)
- Hold mode: 1 (Normal)

It outputs average level sampled while the sampling period.

Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648

Tips
When "High speed mode" is ON, the data won't be updated.
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 ●Auto Average Hold
- Qx Hold: 5 (Average Hold)
- Hold mode: 0 (Auto)

While the Trigger input is OFF, it outputs and keeps average level.
While the Trigger input is ON, it keeps the level sampled at up edge of the trigger input.

Dotted line means original measured value. Full line means output.

ON

OFF

ON

OFF

Measured 
data

Trigger input

RESET
(Y09)

-2147483648

0

+2147483648

Tips
When "High speed mode" is ON, the data won't be updated.
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4.1 Setup software general description

4.1.1 Recommended system requirements
Please make sure that your system meets following requirements.

Item Requirements
PC to run the software Windows based PC
OS  *1 Microsoft Windows XP

Microsoft Windows Vista
Microsoft Windows 7

Main memory 512MB Minimum
HDD 100MB Minimum
I/O port USB / Ethernet *2 / RS-232C *3

QBUS (MELSEC QCPU I/F)
Number of available unit 4 units

*1: You can't use 64 bit Windows.
*2: It doesn't work with MELSEC Q series Ethernet unit QJ71E71-100.
*3: It doesn't work with MELSEC Q series serial communication unit QJ71C24N/-R2/-R4.

4.1.2 Software general description
This software is confi gured as follows.

 

Item Description Reference
Setup screen --- ---

Set destination Choose I/F (USB / Ethernet / RS-232C) between MELSEC CPU. 4.4.1
Unit setup Setup slot number and First I/O number of the unit. You can add/delete 

the unit and copy setup.
It can readout setup information from all UQ1 units connecting to MEL-
SEC CPU.

4.5.1

Calculation setup Setup formula for the calculation in UQ1 unit.
You can input the formula directly and also you can choose the formula 
according to the application e.g. thickness, step.

4.5.3
4.5.4

Sensor head setup Setup parameters of the sensor e.g. measurement target, laser power. 4.5.5
Calibration setup Set "Shift" and "Span" that cancel the deviation of the sensor head 

mounted.
You can input directly and you can also adjust with two point measured 
value.

4.5.6

I/O setup Setup parameters regarding to Input/Output. 4.5.7
Control output setup Setup Upper/Lower threshold to evaluate measured value in UQ1 unit. 4.5.8
Storage setup Setup parameters regarding storage function of UQ1 unit. 4.5.9

Monitor screen --- ---
Measured result Shows measured result and evaluated result. 4.6.1
Storage data. Shows stored data on the graph. 4.6.2
Waveform graph Shows Waveform graph (only with the sensor head that support it). 4.6.3
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4.1.3 Software overview
Overview of this software is as follows.

Item Description Reference
Menu Shows menu of function. 4.1.4
Tool bar Shows tool buttons to choose function. 4.1.5
Tree to choose function You can choose function clicking each function on 

the tree.
---

Main view This is the main view of this software including set-
up and monitor screen.

---
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4.1.4  Menu

Item Description Reference
Project (P) --- ---

New project (N) Create new project. 4.3.1
Open project (O) Open a project. 4.3.2
Save (S) Save the fi le overwriting. 4.3.3Save as (A) Save the project as ---.
Exit (X) Exit the UQ1 Navigator. ---

View (V) --- ---
Unit setup (U) Shows the unit setup screen. 4.5.1
Measured result (M) Shows the measured result on the screen. 4.6.1
Storage data (S) Shows storage data. 4.6.2
Waveform graph (R) Shows Waveform on the graph. 4.6.3

Online (O) --- ---
Set destination (T) Shows screen to set destination. 4.4.1
Readout setup (R) Readout UQ1 unit setup through MELSEC CPU. 4.4.3
Write setup (W) Write setup to UQ1 unit through MELSEC CPU. 4.4.4

Help (H) --- ---
Version (V) Shows version of the software. ---

4.1.5  Tool bar

Item Description Reference
New project Create new project. 4.3.1

Open Open a project. 4.3.2

Save Save the project. 4.3.3

Unit setup Shows unit setup screen. 4.5.1

Measured result Shows measured result. 4.6.1

Storage data Shows stored data on the screen. 4.6.2

Waveform Shows Waveform graph. 4.6.3

Set destination Shows setup screen to set destination.
4.4.1

Readout setup Readout UQ1 unit setup through MELSEC CPU. 4.4.3

Write setup Write setup to UQ1 unit through MELSEC CPU. 4.4.4
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4.2 Software installation

4.2.1 Installation procedure
Installation procedure is as follows. This is example on Windows XP.

Tips
• Please close other application before installation.
• Please log on as Administrator when you install the software.

Start installation

 

 

 

Continue to next page

1. Please double click "Setup.exe" to startup install 
program.

2. Please choose the language and click “OK”.

3. Please click "Next".
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Continue from previous page

 

 

 

 

4. Please input user information and click "Next".

5. Please choose destination folder and click "Next".

6. Please choose program folder and click "Next".

7. Installation is ready now. Please click "Next".

8. When left dialog box is shown, please click "Com-
plete".



4-7

Software installation

4.2.2 Uninstallation procedure
Uninstallation procedure is as follows. This is example on Windows XP.

Tips
• Please exit setup software and referring UQ1 manuals.
• Please log on as Administrator when you install the software.

1. Click "Start" -> "Control panel" -> "Add or Remove 
Programs”.

2. Choose "UQ1 Navigator" in the program list and 
click "Change/Remove".

� 

Start uninstallation

 

 

Continue to next page
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Continue from previous page

 

4. Choose "Remove all installed features." and click 
"Next".

5. Click "Yes" then uninstallation will start.

6. Dialog box like left picture will show then click "Fin-
ish" to complete uninstallation.

4.2.3 Starting up setup software "UQ1 Navigator"
Following is procedure of starting up.

1. Click "Start" -> "OPTEX FA" -> "UQ1 Navigator" -> "UQ1 Navigator".
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4.3 Storing / Loading setup parameters

4.3.1  New project
New project will be created.
The project has been edited will be discarded.

 ● Procedure

1 Choose “Project" -> "Create new fi le" at the menu or click  (Create new fi le) at tool 

bar.

4.3.2  Open project
Open project fi le stored.

 ● Procedure

1 Choose "Project" -> "Open" at the menu or click  (Open) at tool bar.

2 The dialog box "Open fi le" will show then choose the project fi le (attribute: UQ1) and 
click "Open".

4.3.3  Save project
Save the current setup parameters into project fi le.

 ● Procedure

(a) Over writing

Choose "Project" -> "Save" at the menu or click  (Save) at tool bar.
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(b) Saving as

1 Choose "Project" -> "Save as" at menu.
2 The dialog box "Save as" as following shows then specify the project fi le name (at-
tribute: UQ1) and click "Save".
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4.4  Connection with the sequencer

4.4.1  Set destination
Setup communication with MELSEC CPU.

 ● Procedure

Choose "Online" -> "Set destination" or click at the menu  ("Set destination") at tool bar.

 ●Dialog box

Item Discription Reference
USB connection Connection to USB port on the MELSEC CPU. ---
Ethernet connection *1 Connection to Ethernet port on the MELSEC CPU. 

Please refer following "MELSEC Ethernet communi-
cation" in detail.

---

Destination IP address Specify IP address of the Ethernet port on the MEL-
SEC CPU. ---

Ethernet protocol Fixed by "UPD/IP". ---
RS-232C connection *2 Connection to RS-232C port on the MELSEC CPU. ---

COM port Specify the COM port of the PC that the software 
runs on. ---

*1: You can't connect to the Ethernet unit (QJ71E71-100) of MELSEC Q series.
*2: You can't connect to the serial communication unit (QJ71C24N/-R2/-R4) of MELSEC Q series.

 ●MELSEC Ethernet communication
When using the Ethernet port on MELSEC CPU, you have to setup as follows.

1 Setup as follows at "Built-in Ethernet port setup" of "Q parameter setup" on "GX De-
veloper".

IP address: Set IP address as you want.
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* Set “Destination IP address” as the IP address set here.

2 Open “Open setup” and set the port more than one as follows.
Protocol: UPD
Open method: MELSOFT connection

4.4.2 USB Driver setting
USB Driver setting window will show up when you connect the PC to Melsec-Q series through USB for the 
fi rst time. Please install USB driver regarding following procedure.
When you fail installing the driver, please try installing through "Device Manager".

Please note that the setup window for installation varies according to the OS.

 ● Installing procedure
1. When the window "Update Driver Software" 
shows, please click "Browse my computer for driver 
software".

- Window XP will show "Hardware Update Wizard" 
window. Please check "Install from a list or specific 
location" and click "Next".
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Continue from previous page

 

 

2. Please input at "Search for driver software in this location" 
as "C:\MELSEC\EasySocket\USBDrivers" and click "Next". 
You can set the folder referring by clicking "Browse" button.

- The location of the driver depends on your PC. It 
might be at "C:\Program Files\MELSOFT\Easysocket\
USBDrivers".

- Window XP will show "Hardware Update Wizard" 
window. Please choose "Search for the best driver in 
these locations" and check "Include this location in the 
search" then, set the location as above.

3. "Windows Security" window will be shown so please 
click "Install".

- Window XP will show warning window as left picture. 
Please click "Continue Anyway".

4. Installation of the driver software will be successful-
ly fi nished. Please click "Close" and fi nish installation.
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 ●When the window "Update Driver Software" doesn't show
When the window "Update Driver Software” or “Found New Hardware" or "Hardware Update Wizard" doesn't 
show automatically, please run "Device manager" and install the driver.

 

 

1. From "Start menu", choose "Control Panel" and 
then, double click "System and Security".

2. Click "Device Manager" in the "System" part.

3. In the "Device Manager" window, right click at 
"MITSUBISHI" in the "Other devices" and choose 
"Update device" then, installation of the driver will 
start.

- To show "Device Manager" window in case of 
Window XP, please right click "My Computer" and 
choose "Property". "System Properties" window will 
show up then, please click "Device Manager".
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4.4.3  Readout setup
Readout setup parameters of UQ1 unit through MELSEC CPU.

 ● Procedure

1 Choose "Online" -> "Load setup parameters" at the menu or click  ("Load setup 
parameters") at tool bar.

2 Following dialog box shows for confi rmation of reading out setup parameters.

Click "Yes" to readout all setup parameters of the UQ1 unit.
Click "No" just to exit.
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4.4.4  Write setup
Over write setup parameters to UQ1 unit through MELSEC CPU.

 ● Procedure

1 Choose "Online" -> "Store setup parameters" at the menu or click  ("Store setup 
parameters") at tool bar.

2 Following dialog box shows for confi rmation of writing setup parameters.

 
Click "Yes" to over write parameters to all UQ1 unit.
Click "No" just to exit.

3 When click "Yes" at 2, following dialog box shows for confi rmation of writing setup 
parameters of all Banks.

 

Click "Yes" to over write setup parameters of all 60 Banks to UQ1 unit.
Click "No" to over write only common setup parameters to UQ1 unit.

Tips
It will take certain time to over write setup parameters of all 60 Banks. Please click "No" at 3 if you 
don't need over writing parameters.
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4.5 Setup procedure

4.5.1  Unit setup
Please setup as follows.

 ● Procedure

Choose "View" -> "Unit setup" at the menu or click  ("Unit setup") at tool bar.

 ●Dialog box

Item Discription Reference
Unit setup Changing UQ1 unit confi guration and showing the list. ---

Add unit Adding UQ1 unit. ---
Delete unit Deleting UQ1 unit. ---
Copy unit Copying setup of UQ1 unit. ---
Edit unit Changing slot No. and fi rst I/O No. of UQ1 unit. ---
Load unit information Load setup parameters of all UQ1 unit from MELSEC CPU. 

Please refer [4.4 Connection with the sequencer] in detail. 4.4

 ●Unit confi guration list
Discription in detail of UQ1 unit confi guration list is as following.

No. : Shows number of order of UQ1 units.
The number goes as "1", "2", "3", "4"--- from small slot number.

Slot No. : Shows slot number in decimal the UQ1 unit is installed (0~63).
First I/O No. : Shows fi rst I/O number of the UQ1 unit in 4 digit hexadecimal (0000~3FE0).
Unit information : Shows UQ1 unit information in detail.

By double clicking "Unit information", it goes to "Calculation setup (direct)" of the UQ1 unit.
* FIrST communication (infrared communication) can be done between two adjoining UQ1 units.
  The data will be transferred from the unit at bigger slot number to smaller slot number.

 ●Add unit
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You can add unit by clicking "Add unit". It shows a dialog box to set slot number (decimal) and fi rst I/O num-
ber (hexadecimal).
You can add UQ1 unit up to 4 units.
You can't assign same slot number or fi rst I/O number that you have used for other units.

 

 ●Delete unit
You can delete unit by clicking "Delete unit". It shows a dialog box to confi rmation of deleting unit. By clicking 
"Yes", it deletes the unit.

 

 ●Copy unit
By clicking "Copy unit" after choosing unit to copy from, it shows a dialog box.
Please input unit number of copy source and destination then click "OK". It copies setup of source unit to 
destination unit.

 

 ● Edit unit
By clicking "Edit unit" after choosing unit to edit, it shows a dialog box.
Please change the slot number and fi rst I/O number then click "OK". It changes slot number and fi rst I/O 
number.

 



4-19

Setup procedure

4.5.2 Operation of setup screen
You can choose each setup screen by clicking the tab.

(a) From unit setup screen

You can change the screen by clicking unit information at unit setup screen to "Calculation setup (direct)".
 

(b) From screen selection tree

You can change the screen by clicking unit information under "Unit setup" to "Calculation setup (direct)" 
for the selected unit.

 

On the setup parameter screen, you can change the screen by clicking each tab.
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Tips
• Before you change the screen, please click "Apply" button to confi rm changing parameters.
• When you change the screen without clicking "Apply" button, following dialog box will show.

 

"Yes": Confi rm changing parameters and go to another screen.
"No": Discard changing parameters and go to another screen.
"Cancel": Go back to previous screen.

• The parameters confi rmed by clicking "Apply" won't be set actually in UQ1 unit until over writing 
process is done. Please refer [4.4.3 Write setup].
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4.5.3  Calculation setup (Direct)
You can specify elements and operators for the calculation directly.

 ● Procedure
Click "Calculation setup (Direct)" to set parameters for calculation.
Please refer [4.5.2 Operation of setup screen] in detail.

 ● Screen

Item Discription Reference
Formula 1
Formula 2
Formula 3

Specify the calculation formula. The result will be used as mea-
sured result. 3 Formulas can be set per unit.
Please refer [Setup of Formula] in detail.

3.2.3

Formula source 1~5 Specify source of the formula. Default is "None".

3.2.3
Fixed value 1~5 Specify fi xed value for the source of the formula.

Default is "0.00".
Please refer [Setup Fixed value] in detail.

Operator 1~4 Specify operator for the formula. Default is "+".
FIrST data setup --- ---

Transmit data 1
Transmit data 2

Specify which data to transmit by FIrST from slave side to mas-
ter side.
The data transferred through FIrST is referred as "Receiving 
data 1" or "Receiving data 2" at master side unit. 3.2.5

Hold 1
Hold 2

Specify hold process of transferred data. Please refer [3.3 Hold 
mode and process] in detail.

* FIrST communication can be done between adjoining two units (master side and slave side: units at 
smaller slot number and bigger slot number). Please refer [4.5.2 Operation of setup screen].
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 ● Setup Fixed value
Following shows how the fi xed value is set and its unit.

When proximate operator is "+" or "-"

The unit is μm.
Example: Subtracting 500μm from Head B measured value.

 

* Hundredfold of the fi xed value will be stored into shared memory of UQ1 unit in this case.

When proximate operator is " * " or "÷"

The fi xed value will be treated as integer without unit.
Example: Calculate average of measured value of Head A and B.

 

* The value will be stored as it is into shared memory of UQ1 unit in this case.

 ● Setup of Formula
Following shows how to setup formula that is explained at "Example of Formula setup" in [3.2.3 Q1~Q5 / Cal-
culation setup].

Calculation of thickness

Example:  When the thickness of the object is 10mm and "A+B" is 9.2mm.

 

* The "Fixed value" is "800" (L=t-A-B   then   10mm - 9.2mm = 0.8mm = 800μm).

Calculation of step height

Height of the step from the base is calculated by “H=A-B”.
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Calculation of inclination

Example: Calculation of inclination θ (A-B)÷L (L is distance of two sensor heads). When L = 80mm.

* The fi xed value is "80000" (μm).

Getting measured data from adjoining unit

Example:  When calculating average of two Head A connected to each UQ1 unit.
- UQ1 unit 1 (master side)
 

- UQ1 unit 2 (slave side)
Set "FIrST transmit data 1 setup" (shared memory address 109): 0 (Head A)

Getting data from the unit not adjoining

For example, when you use 3 UQ1 units connected as following picture, the data from unit 3 can be transferred to 
unit 1 through unit 2. Unit 1 can’t get the data from unit 3 directly. In this example case, Formula 3 of unit 2 is used 
to assign Receiving data 1 as FIrST Transmit data 1.
- UQ1 unit 1 (master side)

 

- UQ1 unit 2 (center unit)

 

 Set "FIrST Transmit data 1" (shared memory address 109): 4 (Formula 3)

- UQ1 unit 3 (slave side)
 Set "FIrST Transmit data 1" (shared memory address 109): 0 (Head A)
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4.5.4  Calculation setup (Application)
Setup calculation formula by choosing application.

 ● Procedure
Click "Calculation setup (Application)" tab at setup screen.
Pleas refer [4.5.2 Operation of setup screen] in detail.

 ● Screen

Item Description Reference
Application Choose measurement application

Step Measure step difference using two measured result.
Thickness Measure thickness using two measured result.
Average Calculate average of two measured result. ---

Choosing sensor head Choose sensor head to use for calculation. ---
Choosing formula Choose formula for the unit in between two other UQ1 units to 

get measured result from a UQ1 unit that is not adjoining to the 
unit.

---

Please refer [4.5.1 Unit setup].

 ● Setup of formula by choosing application
To setup formula directly, please refer [4.5.3 Calculation setup (direct)].

1 Choose application accordingly
The formula differes according to the application.
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When choose "Step"

Measure step height by using two sensor heads.
The formula will be ["Head 1" - "Head 2"].
 

When choose "Thickness"

Measure thickness by using two sensor heads.
the formula will be ["Head 1" + "Head 2" + "Fixed value"].
 

When choose "Average"

Calculate average of two measured result of two sensor heads.
The formula will be [("Head 1" + "Head 2" ÷ 2].
 

2 Click the button to choose sensor head and formula for center unit at "Choosing 
sensor head" and "Choosing formula".

 

The color of the button changes from "1" (Blue) to "2" (Green) and to "not used" (Yellow) at "Choosing sensor 
head". Please set "1" for "Head 1" and "2" for "Head 2".
The color of the button changes from "use" (Purple) to "not used" (Yellow) at "Choosing formula". Please set 
the formula as "use" for center unit.
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When measure with single UQ1 unit

When measure step height using Head A and Head B connected to single UQ1 unit (unit 1), setup is as 
follows.

 

- UQ1 unit 1
Formula is set as ["Head A" - "Head B"].

 

When measure using adjoining two UQ1 units.

When measure thickness by using adjoining two UQ1 units (Head A connected to Unit 1 and Head B con-
nected to Unit 2), setup is as follows.

 

- UQ1 unit 1 (master side)
Formula is set as ["Head A" + "Receiving data 1" + "Fixed data"(500.00)].

 

- UQ1 unit 2 (slave side)
"Head A" is set for "FIrST Transmit data 1".
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When measure with more than adjoining 3 UQ1 units

When measure average of two sensor heads connected to unit 1 and unit 2, setup is as follows (unit 2 
just transfer the data from unit 3).
* In this example case, formula 3 is used at unit 2 to transfer the data.

 

- UQ1 unit 1 (master side)
The formula is set as ["Head A" + "Receiving data 1" ÷ "Fixed value"(2)].

- UQ1 unit 2 (center unit)
The formula 3 is set as ["Receiving data 1"].

 

"FIrST Transmit data 1" is set as "Formula 3".

- UQ1 unit 3 (slave side)
"FIrST Transmit data 1" is set as "Head A".

Tips
• Please don't change the formula chosen at center unit by calculation setup.
• When measure using more than two UQ1 units, if "FIsST Transmit data" of UQ1 at slave side is 

used for other formula, you can't make any formula.
• When add/delete unit at "Unit setup" screen, all setup of "Calculation setup (Application)" will be 

deleted.
* Formula won't be deleted.
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4.5.5  Sensor head setup
Setup parameters relevant to measurement by sensor head itself.

 ● Procedure
Click "Sensor head" tab at setup screen.
Please refer [4.5.2 Operation of setup screen] in detail.

 ● Screen
UQ1-01

UQ1-02
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Item Description Reference

Sensor Head A setup
Sensor Head B setup

---

3.2.1

Measurement target Specify measurement target
- Peak:  Measure most refl ective surface (UQ1-02).
- Surface:  Measure fi rst surface.
- Flip side:  Measure 2nd surface.
- Glass thickness:
 Measure the distance between fi rst surface and
 2nd surface.
- Glass gap:
 Measure the distance between 2nd surface and
 3rd surface (UQ1-01).

Use "Surface" or "Peak" normally.
Diffuse type of CD33 must be used as "Peak".

Diffuse/Specular
(Only with UQ1-01)

Specify its mode.

Laser power - UQ1-01: Set laser power from "1" (Minimum) to "5" (Maximum).
  When "0" is set, it doesn't emit laser.
- UQ1-02: Specify ON/OFF of laser power.

Sensitivity setup
(only UQ1-01)

Setup sensitivity of photoelectric sensor. Set "AUTO" normally.
When set "AUTO", it adjust sensitivity depends on reflection from 
work piece automatically.
Please set from "0" (Minimum) to "10" (Maximum) when you set 
manually.

Waveform threshold
(only UQ1-01)

Setup threshold to detect peak in the Waveform data. It's used with 
"0" normally.
Please set from "0" (low) to "14" (high) when you setup manually.
When it's set "AUTO", it will measure in anycase but resolution 
might be worse.

Moving average num-
ber

Setup moving average number.
The bigger number, the more stably it can measure and it can pre-
vent too much effection from fi ne roughness of the surface.
The smaller number, the quicker it can response.
Default is "256"(UQ1-01) / "16"(UQ1-02).

Sampling period Setup sampling period of measurement. The smaller period, the 
faster response but sensitivity will be worse.
You can set "AUTO" with UQ1-01. CD5 series sensor head adjust 
sampling period automatically to measure in optimum condition.
Default is "100us"(UQ1-01) / "500us"(UQ1-02).

Sensor head A/B common 
setup

* only for UQ1-01.

Prevent cross talk func-
tion

This function prevent cross talk between two sensor heads though, 
sampling period will be 6 times longer.
Default is "OFF".

Filter You can use "High pass fi lter" or "Low pass fi lter".
Default is "OFF".

Cut off frequency Specify cut off frequency when you use filter function. It's from 
"0"(high) to "7"(low).
Default is "0".

3.2.1
6.1.1
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4.5.6  Calibration setup
Setup parameters relevant to calibration of the sensor head.

 ● Procedure
Please click "Calibration" tab at setup screen.
Please refer [4.5.2 Operation of setup screen].

 ● Screen

Item Description Reference
Setup from measured result It calculates "Span" and "Shift" from two measured points given. ---

1st point
2nd point

Click the ckeck box accordingly when get the measured result 
from UQ1. ---

Getting measured value Get the measured value for 1st point or 2nd point which check 
box is checked. ---

Measured value Set measured value before calibration. ---
Display value Shows the value after calibration. ---

Span, Shift direct input Input "Span" and "Shift" directly. ---
Span Set "Span" value.

 Example: When you want to increase "10mm" for
         every "9.5mm", the "Span" is as follows.
         9.5 / 10 = 0.9500
Default is "1.0000". 3.2.1Shift Set "Shift" value.
 Example: When you want to adjust measured value "0mm" to
          "+0.15mm", the "Shift" is as follows.
          0.15 * 1000 = 150.00 um
Default is "0.00".
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 ●Automatic calculation of "Span" and "Shift"
Following shows how to calculate "Span" and "Shift" automatically with two measured points given.

1 Select "Setup from measured value"

2 Set two measured points
Set actual measured value before calibration into "Measured value" and expected value into "Display val-
ue". When you want to get these value from UQ1, please check the check box of "First point" or "Second 
point" and click "Getting measured value" button.

3 You can get calibrated "Span" and "Shift" automatically by clicking "Apply".
Before 
Calibration

After 
Calibration

1st Point

2nd Point

Measured value

Display 
value

1st Point

1st Point

2nd Point

2nd Point
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4.5.7  I/O setup

 ● Procedure
Please click "I/O setup" at setup screen.
Please refer [4.5.2 Operation of setup screen] in detail.

 ● Screen

Item Description Reference

Input setup --- ---
Input terminal 1
Input terminal 2

Specify which target the "Trigger IN1" and "Trigger IN2" to use for.
Default is "Head A" for "Trigger IN1" and "Head B" for "Trigger IN2".

3.2.5

Timing of data 
sampling

Specify process mode of "Trigger IN1" and "Trigger IN2".
- OFF: Retrieve data while the trigger is OFF.
- ON : Retrieve data while the trigger is ON.
- Up edge: Retrieve data at trigger up edge.
- Down edge: Retrieve data at trigger down edge.

Default is "OFF".
When the input is specifi ed as "RESET", it works at upedge.

Output setup --- ---
Output terminal 1
Output terminal 2

Specify which evaluated result to output from "Signal OUT1" and "Signal 
OUT2".
Default is "Q1" for "Signal OUT1" and "Q2" for "Signal OUT2".

3.2.5

Signal Out logic Specify logic of "Signal OUT1" and "Signal OUT2".
- 0: All normal (ON when NG. OFF when OK).
- 1: OUT1 is reverse (OUT1 is ON when OK).
- 2: OUT2 is reverse (OUT2 is ON when OK).
- 3: All reverse (ON when OK. OFF when NG).

Default is "0" (All normal).
One shot Specify if set one shot output or not.

Default is "OFF".
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ON delay
OFF delay

Specify if use ON/OFF delay or not and delay time in "ms" from "0" to 
"65535".
Default is "0".
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4.5.8  Control output setup

 ● Procedure
Please click "Control output setup" at setup screen.
Please refer [4.5.2 Operation of setup screen] in detail.

 ● Screen

Item Description Reference
Control output setup --- ---

Q1~Q5 Source Specify the source for Q1~Q5.
Default is "Head A" for Q1, "Head B" for Q2 and "None" for others. 3.2.3Q1~Q5 Hold Specify hold mode of Q1~Q5.
Default is "None".

Bank number Specify Bank number to readout/overwrite "Upper/Lower threshold" 
and "Offset" of Q1~Q5 from/to the PLC. Please set from "0" to "59". ---

Readout Bank setup Readout "Upper/Lower threshold" and "Offset" of Q1~Q5 from speci-
fi ed Bank. ---

Over writing Bank 
setup

Over write "Upper/Lower threshold" and "Offset" of Q1~Q5 set on the 
screen to specifi ed Bank. ---

Lower limit
Upper limit

Specify threshold of Q1~Q5. Set from "-2147483648" to 
"2147483647".
Default is "-75000000" for Lower limit and "75000000" for Upper limit. 3.2.8

Offset Specify offset of Q1~Q5. Set from "-2147483648" to "2147483647".
Default is "0".

Hold mode Specify Hold mode.
Default is "Auto".
Please refer [3.3 Hold mode and process] in detail.

3.2.4
3.3
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Hysteresis Specify hysteresis of Q1~Q5 that means level difference from "ON" to 
"OFF".
Set from "0.00" to "21474836.47".
Default is "0.00".

3.2.4

High speed mode Specify if let it work in high speed mode or not. In high speed mode, it 
doesn't average while processing. Default is "OFF". 3.2.2

Tips
• You can over write every Bank one by one and also over write all 60 Banks at a time on this setup 

screen.
• Over writing one by one is recommended because over writing 60 Banks at a time.
• If you want to over write 60 Banks at a time, please refer [4.4.3 Write setup].
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4.5.9  Storage setup

 ● Procedure
Please click "Storage" tab on the setup screen.
Please refer [4.5.2 Operation of setup screen] in detail.

 ● Screen

Item Description Reference
Storage setup --- ---

Storage target Specify target for storage.
Default is "Q1". 3.2.6

Hold mode Specify hold mode for storage.
This parameter is effective only for Head A/B and Formula 1/2/3.
Default is "None".

Pointer clear timing Specify timing to clear the storage pointer.
- When trigger is ON:

When trigger is ON, the pointer is cleared.
- When RESET is ON:

When RESET (Y09) is ON, the pointer is cleared.
Default is "When RESET is ON".
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Sampling period Specify sampling period from "1" to "65536". Default is "1" and it 
sores every data.
* The parameter "Data store skip number" of UQ1 will be [this num-
ber - 1].

Example: When this number is 10, it samples data every 10 
sampling period. "Data sore skip number" will be "9".

Sampling period (us) will be bigger sampling period out of Head A 
and Head B. Please refer [4.5.5 Sensor head setup].

Example: When Head A: 200us and Head B: 800us, then it will 
be "800".

When one of the Heads is set as "AUTO", it will be "AUTO".

3.2.6
4.5.5

Time of storing data Shows total time to store all 262144 points of data.
Example: When Sampling period is "1" and "800"us,
0.8ms * 1 * 262144 = 209715.2ms (around 209.715sec)

When of of the Heads is set as "AUTO", it will show "----".

---

When pointer reach-
es end

Specify the process when the pointer reaches end of storage mem-
ory.

- Stop: Stop the storage rocess.
- Continue from start: Clear the pointer and start storing data 
from start of the memory.

Default is "Continue from start"

3.2.6

Tips
UQ1-01 later version than 2 support storing 2 measurement result.
You can confi rm the version on the label.
There is version number above the "CE" mark.
With no version shown as following picture it's version 1.

If you proceed storing 2 measurement result with UQ1 of version 1, it will store only one measure-
ment result of Q1 with Hold mode: "None".



4-38

Confi rming process

4.6 Confi rming process

4.6.1  Measured result
It monitors UQ1 mesurement result and evaluation result.

 ● Procedure
Choose "Display" -> "Mesurement result" from the menu or

click the icon  "Measurement result" at choosing screen tree.

 ● Screen

Item Description Reference
Unit Choose the UQ1 unit (1~4) to monitor. ---
Bank number Choose the Bank number (0~59) to monitor. ---
Control output (Q) Choose the control output (Q1~Q5) to monitor. ---
Monitoring start
Monitoring stop

Switch start/stop of monitoring of UQ1 control output. ---

Measurement result Shows measurement result in μm and measurement source. 3.2.3
Zero reset It adjust offset value so that the measurement result shows "0". 3.2.9

Out of range Shows "Out of range" alarm of Head A/B.
Alarm ON: Red
Alarm OFF: Gray

---

Process time Shows current process time in μs. 3.2.11
Control output Shows if each control output is in the threshold or not.

In the threshold: Green
Out of the threshold: Red

3.1.3

Input terminal Input trigger for Head A/B and Formula 1/2/3.
ON: Blue
OFF: Gray

---
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Reset Reset UQ1. ---
Error Shows error status of sensor head connection, receiving data, each 

control output and calculation.
Alarm ON: Red
Alarm OFF: Gray

3.1.3
3.2.10

Error release Release the UQ1 error. ---
Initialize It shows a dialog box for confi rmation by clicking the button. When you 

click "Yes" at the dialog box, it will initialize setup parameters. ---
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4.6.2  Storage data
It shows UQ1 storage data in a graph.

 ● Procedure
Choose "Display" -> "Storage data" from the menu or

click "Storage data" icon  from the tool bar or screen selection tree.

 ● Screen

Item Description Reference

Vertical scale Choose the vertical scale.
Auto: Adjust the Min./Max. scale so that to display all data.
Fixed: The scale is fi xed with the value at the Min./Max. boxes.

---

Display data --- ---
All Both data 1 and 2 will be displayed. ---
Data 1/2 Data 1 or 2 will be displayed. ---

Horizontal scale Min./Max. Shows horizontal scale Min./Max. (storage fi rst No./last No.).
Please edit the scale and click "Refreshing the graph" button.
* UQ1 storage data will be over written by clicking "Loading data" 
button.

---

Loading data stored --- ---
Number of data stored Specify number of data sotred to load from UQ1.

Set from "1" to "262144".
Default is "100000".

---

Loading data Load the data from UQ1 and show on the graph. ---
Save CSV data Save the storage data loaded into CSV fi le. ---

Refreshing the graph --- ---
Number of data loaded Shows number of data loaded. ---
Storage fi rst No. Shows fi rst number of storage data loaded. ---
Storage last No. Shows last number of storage data loaded. ---
Refreshing the graph Refreshes and shows the graph.

This is used when you refresh the graph after editing vertical and 
horizontal scale.

---
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 ●Changing scale

Standard setup

Set vertical scale as "Auto" and click "Loading data" or "Refreshing the graph".

 

Changing vertical scale

When you change vertical scale, please click "Fixed" at Vertical scale and change the vertical Min./Max. 
scale value. Input the scale and click "Refreshing the graph" to show the graph in the new scale.
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 Changing horizontal scale

When you change horizontal scale, please change Min./Max. horizontal scale.
Input Min./Max. scale and click "Refreshing graph" to show the graph in new scale.
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4.6.3  Waveform data
Shows Waveform. In case of CD33 series, it can show the Waveform only with specular type. Vertical axis 
shows light strength and horizontal axis shows distance.
Please refer [3.2.13 Waveform data] in detail.

 ● Procedure
Choose "Display" -> "Waveform" from the menu or

click  "Waveform" button from the tool bar or screen selection tree.

 ● Screen

Item Description Reference
Head selection Choose sensor head to monitor its Waveform. ---
Detailed information --- ---

Threshold for peak 
detection

Shows threshold level of Waveform to detect the peak.
Blue broken line shows the threshold level. 3.2.13Peak 1

Peak 2
Shows Peak 1/2 that CD5 recognizes as peak.
Left peak is fi rst peak and another is second peak.

Monitoring start
Monitoring stop

Switch start/stop of monitoring of Waveform through UQ1. ---
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5.1.1  Function

LED indicators on UQ1 don't light.

UQ1 unit may not installed on the Q bus correctly.
• Please make sure UQ1 unit is installed on the Q bus correctly.

LED indicators on CD5 don't light

Power supply may not be connected to CD5.
• Please make sure the power supply is connected correctly.

Cable may not be connected correctly.
• Please make sure the connectors of the cable are connected correctly.

The cable may be broken.
• Please try replacing the cable.
• Please make sure the cable is not used at moving part.

The laser isn't emitted

"Laser OFF" (Y12/Y13) may be 1=OFF.
• Please set "Laser OFF" as 0=ON.

"Laser power" of CD5 may be "0" (UQ1-01).
• Please set "Laser power" (shared memory 2/16) as 1~5 and set "Over writing common setup" 

(Y10) to over write the setup.

LED indicators light by rotation.

It means UQ1 has system error.
• When it doesn't recover after re-booting, please contact distributor you bought the unit from.

One of following LEDs light in red.

It means communication between the UQ1 unit and other equipment (QCPU, CD5/CD33, adjoining UQ1 
unit).

• When it doesn't recover after making sure that there is no big noise from other equipment and the 
connection is made correctly, please contact our distributor you bought the unit from.

ERR LED of the UQ1 unit lights

Sensor head assigned for Q1~Q5 may be not connected.
• Please make sure the sensor head is connected correctly.

UQ1-01
JUDGE

1    2   3   4   5

<<<<NEAR FAR>>>>LNK
ERR.
HEAD  A
HEAD  B

OUT 1   2
  IN   1   2
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5.1.2 Measurement

"Head A/B out of range alarm" is ON and measurement isn't done correctly.

Stand off distance may be not correct.
• The distance between the sensor head and the object must be in the measurement range. Please 

refer the manual and make sure the distance is in the range.
Angle of the sensor head may be not correct.

• Diffuse type sensor head must be mounted so the laser angle is vertical to the object. Specular 
tyep sensor head must be mounted as specifi ed on the manual. Otherwise the sensor head won't 
be able to receive enough light refl ected by the object.

There may be blockade between the sensor head and the object.
• The sensor head won't be able to receive light refl ected by the object if there is blockade. Please 

make sure there is no blockade. Please refer the manual.
The refl ected light may be not enough (when the object is transparent or mirror surface).

• When measure transparent object or mirror surface, please use specular type sensor head.
The refl ected light may be not enough (when the object is mat dark or angled).

• Please try increasing laser power or sampling period so that the sensor head is able to receive 
enough light refl ected.

Measurement data is not updated.

Trigger input may be ON.
When the trigger input is ON, the measurement data won't be updated. Please check "Trigger IN" 
(Y0A~Y0E).

Hold mode may be activated.
• Please make sure "Qx Hold" is set adequately.

BUSY may be ON.
• Please make sure any "BUSY" (X10~X15) is not ON.

Waveform mode may be activated.
• Pleas make sure "Head A/B Waveform mode" (Y14, Y15) is not ON.

Measurement result keeps the level "0".

Connection may be broken.
• Please make sure cable and connection is made correctly.

The sensor head not connected may be assigned for the formula.
• The sensor head not connected or receiving data not availabe may be assigned for the formula. 

Please make sure all sources of the formula are available.
The operator "*" or "÷" is used in the formula.

• Calculation result could be "0" because of the formula especially by the operator "*" or "÷". Please 
make sure the formula is built adequately.

Measurement result is not stable.

The number of averaging may be small.
When the number of averaging is smaller, the response speed is faster but the measurement re-
sult could be not stable. Please try increasing the number of averaging.
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The CD5/CD33 sensor head doesn't match for the application.
The smaller measurement range, the more stable the measurement result will be. Please try sen-
sor head with smaller measurement range.

The measurement result is bigger than what expected.

The sensor head may be tilted from correct position.
• When the sensor head is tilted, the measurement result could be bigger than the measurement 

result expected. Please check mounting angle of the sensor head.
• Please calibrate the sensor head with gauge or object that you know the exact dimensions. Cali-

bration can be done by setup software.

The measurement result is far different from what expected.

Filtering may be activated.
• High pass or Low pass fi lter may be activated.
• Please set "Filter choice" (shared memory 29) as OFF and check how it works.

Hold mode may be activated.
• Hold mode may be set as "Peak to Peak hold mode".
• Please check setup of "Qx Hold" (shared memory 33/35/37/39/41).
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5.1.3 UQ1 shared memory , X/Y device

Data can't be read from shared memory or updated.

The unit information (slot number, fi rst I/O number) doesn't match to actual PLC unit confi guration.
• Please check the setup of unit information (slot number, fi rst I/O number). Please refer [4.5.1  Unit 

setup] in detail.
Error is ON on UQ1 unit.

• Please check if there is any Error on "Measurement result" screen of setup software or check uti-
lizing GX-Works/GX-Developer. Please try activating "Error release" (Y16) or "Initialize" (shared 
memory 127) if needed. Refer [4.6.1  Measurement result] in detail.

UQ1 is BUSY.
• Changing setup or storing data into storage may be under process and shared memory data is 

not available to read. Please check BUSY status at X device and make sure to read shared mem-
ory after checking the BUSY is OFF.

Overfl ow in the calculation.

The formula may not be adequate.
• The calculation result may be overfl owing by multiplication with too big number.
• Please check "Overfl ow" (shared memory 320). You can see what the factor of overfl ow is.

The receiving data 1/2 is not available.

The slave side UQ1 unit may not be installed next to master side UQ1 unit.
• FIrST communication can be done between adjoining UQ1 units installed on Q bus.

There may be blockade between the UQ1 units.
• Please make sure there is no blockade like small slip of paper between the UQ1 units.

The receiving data 1/2 is different from what expected.

FIrST setup may be done at master side UQ1 unit.
• FIrST setup must be done at slave side UQ1 unit. Please check parameters at slave side UQ1 

unit.

Setup changed is not refl ected to actual process.

Over writing may not be done.
• Changing on the shared memory won't be refl ected by just changing it.
• Please set "Over writing common setup" (Y10) as ON to refl ect the setup to actual process. While 

it's over writing, you can't read shared memory.

Changing Bank is not refl ected to actual process.

Over writing may not be done.
• Changing "Bank number" (shared memory 102) won't be refl ected by just changing it. Please set 

"Switching Bank" (Y08) as ON to refl ect changing Bank. While changing Bank, you can't read 
shared memory.
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BUSY (X device) status can't be recognized.

BUSY period may be very short.
• BUSY will be ON while UQ1 unit is over writing setup or changing Bank. UQ1 process timing is 

independent to sequencer scan timing so the sequencer may not be able to recognize the BUSY 
activated.
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5.1.4 Setup software

Setup software can't be installed.

Please make sure to install the software as administrator user.
• When the user mode is not sure, please ask your IT/network manager.

Connection to UQ1 unit can't be done from setup software.

Please make sure there is no problem at communication with PLC and setup on "Set destination" screen.

• Pleaser refer [4.4.1  Set destination] in detail.

Changes on “UQ1-Navigator" doesn't affect actual function

Changes on "UQ1-Navigator" will be applied by clicking "Apply" and  "Store setup parameters".
Without this process, any changes won't be applied on actual function.

• Pleaser refer [4.4.1  Set destination] in detail.

Communication error while using setup software.

Please make sure the communication cable is connected correctly and power supply of PLC is connected 

and ON.

"Set destination", "Read out setup" and "Over write setup" can't be selected.

"Set destination", "Read out setup" and "Over write setup" can't be selected while monitoring measure-
ment result and Waveform.

• Please stop monitoring.

Waveform graph doesn't show (UQ1-02)

Only specular type of CD33 (CD33-Lxx) support Waveform mode.
• Please check sensor type.

The setup software can't be fi nished.

"Set destination", "Read out setup" and "Over write setup" can't be selected while monitoring measure-
ment result and Waveform.

• please stop monitoring.
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5.1.5 Term

Offset

• Offset value is added (subtracted) on (from) measurement result so that you can see the distance from 
any base position.

• Offset value will be set automatically to show the measurement result as "0" by clicking "Zero reset" but-
ton on the setup software.

Update period

• Update period is the timing that UQ1 unit calculate, output and communicate.
• It's rounded out value of actual response speed (shared memory 327) by 100μs. For example, when the 

response speed is 140μs, update period will be 200μs.



6
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6.1.1  Cutoff frequency of the fi lter (UQ1-01)
The cutoff frequency of the fi lter is defi ned by "Filter choice" (shared memory 29), "Cutoff frequency" (shared 
memory 30) and "Sampling period" (shared memory 11, 25). Please refer the cutoff frequency in following 
table.

    

Sampling period: 100us

Cutoff frequency HPF LPF

0 650 Hz 2000 Hz

1 350 Hz 800 Hz

2 200 Hz 400 Hz

3 100 Hz 200 Hz

4 50 Hz 100 Hz

5 25 Hz 50 Hz

6 15 Hz 20 Hz

7 10 Hz 10 Hz

Sampling period: 200us

Cutoff frequency HPF LPF

0 325 Hz 1000 Hz

1 175 Hz 400 Hz

2 100 Hz 200 Hz

3 50 Hz 100 Hz

4 25 Hz 50 Hz

5 12.5 Hz 25 Hz

6 7.5 Hz 10 Hz

7 5 Hz 5 Hz

Sampling period: 400us

Cutoff frequency HPF LPF

0 162.5 Hz 500 Hz

1 87.5 Hz 200 Hz

2 50 Hz 100 Hz

3 25 Hz 50 Hz

4 12.5 Hz 25 Hz

5 6.25 Hz 12.5 Hz

6 3.75 Hz 5 Hz

7 2.5 Hz 2.5 Hz
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Sampling period: 800us

Cutoff frequency HPF LPF

0 81.25 Hz 250 Hz

1 43.75 Hz 100 Hz

2 25 Hz 50 Hz

3 12.5 Hz 25 Hz

4 6.25 Hz 12.5 Hz

5 3.125 Hz 6.25 Hz

6 1.875 Hz 2.5 Hz

7 1.25 Hz 1.25 Hz

Sampling period: 1600us

Cutoff frequency HPF LPF

0 40.625 Hz 125 Hz

1 21.875 Hz 50 Hz

2 12.5 Hz 25 Hz

3 6.25 Hz 12.5 Hz

4 3.125 Hz 6.25 Hz

5 1.5625 Hz 3.125 Hz

6 0.9375 Hz 1.25 Hz

7 0.625 Hz 0.625 Hz

Sampling period: 3200us

Cutoff frequency HPF LPF

0 20.3125 Hz 62.5 Hz

1 10.9375 Hz 25 Hz

2 6.25 Hz 12.5 Hz

3 3.125 Hz 6.25 Hz

4 1.5625 Hz 3.125 Hz

5 0.78125 Hz 1.5625 Hz

6 0.46875 Hz 0.625 Hz

7 0.3125 Hz 0.3125 Hz
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